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Important Information for Users 
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been made and what revisions, if any, have been incorporated. 
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images only and should not be construed as absolute references. Discrepancies between the images in this 
document and the actual application design are not a cause for revisions to this document. 
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Public Release Data Set Information 

This document details the Lab Protocol for testing the items listed in the following table: 

Data File Name Variable Name SAS Label 

IHGEM_L 

LBXIHG Mercury, Inorganic (μg/L) 

LBXIHGSI Mercury, Inorganic (nmol/L) 

LBXBEG Mercury, ethyl (µg/L) 

LBXBEGSI Mercury, ethyl (nmol/L) 

LBXBEM Mercury, methyl (µg/L) 

LBXBEMSI Mercury, methyl (nmol/L) 
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1. Summary of Clinical Relevance and Principle 

A. Clinical Relevance 

Mercury (Hg) is widespread in the environment and found in its elemental form (Hg0), inorganic 
forms such as mercurous (Hg+) and mercuric (Hg2+), and various organic forms such as 
methylmercury (MeHg), ethyl mercury (EtHg), phenyl mercury (PhHg) and others. The health 
effects of mercury are diverse and are dependent upon the form of mercury encountered and 
the severity and length of exposure. The relative order of increasing toxicity is Hg0 < Hg2+ << 
CH3Hg+ [1]. With large acute exposures to elemental mercury vapor, the lungs may be injured. 
At levels below those that can cause lung injury, low-dose or chronic inhalation may affect the 
nervous system. Symptoms include weakness, fatigue, loss of weight (with anorexia), 
gastrointestinal disturbances, salivation, tremors, and behavioral and personality changes, 
including depression and emotional instability [2]. Exposure to inorganic mercury usually occurs 
by ingestion. The most significant effect of inorganic exposure occurs on the kidneys, where 
mercury accumulates, leading to tubular necrosis. In addition, there may be an irritant or 
corrosive effect on the gastrointestinal tract involving stomatitis, ulceration, diarrhea, vomiting, 
and bleeding. Psychomotor and neuromuscular effects also may occur [3].  

Methylmercury is more toxic than inorganic mercury. The effects of methylmercury include 
changes in vision, sensory disturbances in the arms and legs, cognitive disturbances, dermatitis, 
and muscle wasting. The critical organ for methylmercury is the brain. Methylmercury readily 
crosses the blood-brain barrier due to its lipid solubility and accumulates in the brain where it is 
slowly converted to inorganic mercury. Whether CNS damage is due to methylmercury or 
inorganic mercury, or both, is still controversial [4].  

Ethyl mercury is another organic form of mercury. Very little is known about ethyl mercury 
metabolism in humans, including whether it has the same potency as a neurotoxin, whether the 
blood concentration is ever significant, and even whether it crosses the blood-brain barrier. 
However, the use of thimerosal, which metabolizes to ethyl mercury and thiosalicylate, as a 
vaccine preservative makes this subject very important. 

In the general population, total blood mercury exposure is due mostly to the dietary intake of 
organic forms, particularly methylmercury, and ranges from 0.2 to 5.8 µg/L [5]. Urinary mercury 
is mainly comprised of inorganic mercury due generally to dental amalgam containing elemental 
mercury and occupational exposures ranging from 0.2 to 10 µg/L [5]. 

This hyphenated method assesses mercury exposure as defined by exposure to individual 
mercury species, by analyzing blood through the use of a Solid Phase Micro Extraction (SPME) 
fiber for delivering sample to a gas chromatograph (GC) coupled to an inductively coupled 
plasma-dynamic reaction cell-mass spectrometer (ICP-DRC-MS). The method provides accurate 
quantification of three mercury blood species: inorganic mercury (InHg), methylmercury 
(MeHg), and ethyl mercury (EtHg) as listed in Error! Reference source not found.. Whole blood 
was determined to be the most suitable matrix to monitor species-specific exposure because if 
exposed to organic and/or inorganic forms of mercury, blood will contain various organic 
mercury species as well as inorganic mercury while urine contains mostly inorganic mercury.  
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Table 1 Mercury Species Quantified with this Method 

Species Name Abbreviation Molecular Structure 

Inorganic mercury InHg Hg2+ 
Methylmercury MeHg CH3Hg+ 
Ethyl mercury EtHg C2H5Hg+ 

 

B. Test Principle 

The quantification of InHg, MeHg, and EtHg in whole blood samples is performed using a triple 
spike isotope dilution (TSID) method employing gas chromatography (GC) to separate the 
species followed by introduction into an ICP-DRC-MS for detection. TSID is a specialized 
extension of the Isotope Dilution (ID) technique. TSID measures individual chemical species 
(inorganic, methyl and ethyl mercury species) in samples using ID principles. The blood sample is 
spiked with known amounts of each Hg species that have been enriched with isotopic variants of 
the target element of interest.  

The first step of this method involves the addition ("spiking") of enriched isotopes (199Hg2+, 
CH3

200Hg+, and C2H5
201Hg+ or C2H5

198Hg+, 199Hg2+, and CH3
201Hg+) to the blood sample. Each Hg 

species spike is labeled with an enriched Hg isotope such that its isotopic pattern is unique to 
the species' chemical identity (i.e. the manner of isotope spiking is "species specific"). Next, the 
spiked sample is digested in tetramethylammonium hydroxide (TMAH) which disassociates 
bound mercury species from proteins, polypeptides, and other biomolecules. The digested 
blood sample with freed mercury species is chemically reacted ("derivatized") with a reagent 
that adds 3-carbon chains (n-propyl groups) to the mercury atom of each species molecule 
without compromising species identity. This type of chemical derivatization results in loss of 
ionic charge and reduced polarity making each mercury species molecule volatile so that it can 
escape the liquid phase and accumulate in the gaseous phase ("headspace") directly above the 
sample. Derivatization is performed inside a partially filled vial sealed with a rubber septa cap 
that can be penetrated by a needle.  

Solid Phase Microextraction (SPME) is a sampling technique that uses a thin polymer fiber with a 
hydrophobic coating. The method described here uses a SPME fiber with a 100 µm coating of 
polydimethylsiloxane (PDMS). The SPME assembly consists of the fiber inserted in a stainless-
steel needle. A key design feature is that the fiber can be mechanically withdrawn into the 
needle during vial septum penetration and then pushed out to expose the fiber to the 
headspace. During headspace exposure (the "extraction" step), the gaseous derivatized Hg 
species adsorbs onto the PDMS coating of the SPME fiber. When other factors are held 
constant, the adsorbed mass increases as a function of sample concentration. After a 
predetermined time, the SPME fiber is retracted into the injection needle, and the needle is 
withdrawn from the sample vial. Subsequently, the needle moves to the injector port of the 
programmable temperature gradient gas chromatograph, (GC) and on programmatic command, 
performs a programmed temperature ramp injection sequence. This action transfers the 
propylated inorganic, methyl and ethyl Hg species to the head of a 30 m capillary GC column 
which, using He as the carrier gas, ramps the column temperature to 280°C. The order of 
chromatographic separation of the Hg species is based on increasing molecular weight: 
methylpropylmercury (derivatized methyl Hg), ethylpropylmercury (derivatized ethyl Hg), 
followed by dipropylmercury (derivatized inorganic Hg). Hg species exiting the GC column are 
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seen as chromatographic peaks detected using an inductively coupled argon plasma (ICP) as the 
ion source and a quadrupole mass spectrometer (MS) for mass specific quantification. Species 
identification is based on chromatographic retention time. Species-specific isotope ratios are 
calculated from integrated peak areas derived from m/z signals corresponding to 199Hg, 200Hg, 
201Hg, and 202Hg isotopes or 198Hg, 199Hg, 201Hg, and 202Hg isotopes. We operate the ICP-MS in a 
Dynamic Reaction Cell (DRC™) mode to enhance Hg signal strength through an effect known as 
"collisional focusing" [6, 7]. 

2. Safety Precautions 

A. Observe all safety regulations as detailed in the Division Laboratory Safety Manual [8] and the 
laboratory Chemical Hygiene Plan. 

B. Observe universal precautions when handling biological specimens. Wear gloves, a lab coat, and 
safety glasses while handling human blood, plasma, serum, urine or other bodily fluid or tissue. 
Bloodborne pathogens training is required.  

C. Work with open vials containing biological samples inside of a biological safety cabinet (BSC). 
Recap vials before removing them from BSC. 

D. Handle acids and bases with extreme care; they are caustic and toxic. Reagents used in this 
study include those listed in Section 6. Safety Data Sheet documents (SDS) for these chemicals 
are readily accessible as hard copies in the lab. If needed, electronic versions of SDS for other 
chemicals can be viewed at http://www.ilpi.com/msds/index.html or internally in the Chemical 
Hazard and Tracking System (CHaTS). 

E. Operators of this method must take the Hazardous Chemical Waste Management for CDC 
Workers course upon initial hire and yearly refreshers thereafter.  

F. Place disposable items (e.g., pipette tips, autosampler tubes, and gloves) that come in contact 
with human biological fluids, such as urine, in a biohazard autoclave bag. Keep these bags in 
appropriate containers until they are sealed and autoclaved. 

G. Dispose of all diluted biological specimens in a biohazard autoclave bag at the end of the 
analysis according to CDC/DLS guidelines for disposal of hazardous waste. 

Important 

Precautionary information that is important to protecting personnel and safeguarding equipment 
will be presented inside a box, like this one, throughout the procedure where appropriate. 

Caution! 

Exercise caution when handling and dispensing concentrated nitric and hydrochloric acid. Always 
remember to add acid to water. Nitric and hydrochloric acid are corrosive chemicals that are 

capable of severe eye and skin damage. Wear powder-free gloves, a lab coat, and safety glasses. 
Open and transfer acids in the fume hood or BSC, otherwise face shield should we worn. If nitric or 
hydrochloric acid comes in contact with any part of the body, quickly wash the exposed area with 

copious quantities of water for at least 15 minutes. 
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H. When work is finished, spray all work surfaces where human biological fluids were handled with 
a broad-spectrum disinfectant or other appropriate disinfectant.  

I. Review safety information for all instruments and equipment used with this method. Safety 
hazards from equipment and instruments in the laboratory may include ultraviolet radiation, 
high voltages, radio-frequency radiation, high temperatures and compressed gases. 

 

3. Computerization; Data System Management 

A. During sample preparation and analysis, samples are identified by their sample ID. The sample 
ID is a number that is unique to each sample that links the laboratory information to 
demographic data recorded by those who collected the sample. Sample IDs are entered into the 
ICP-MS instrument software using a barcode scanner, whenever possible. If hand entry of a 
sample IDs is necessary, proofread transcribed data after entry.  

B. The software used to control the instrument system (e.g., HPLC and ICP-MS), and raw data files 
are stored on the instrument control computer. The directories storing analytical run data are 
backed up nightly to the Isolated Secure Lab Environment (ISLE), which is then backed up weekly 
to the CDC network through a process setup by the Division’s Laboratory Informatics Support 
team. Verify network backups as part of monthly computer maintenance (see Section 8.B(5)). 
Request Helpdesk support for data backup issues through the Laboratory Informatics Support 
Tool (LIST) in the Division of Laboratory Sciences (DLS) STARLIMS app. 

C. The electronic files containing the data from the analysis are stored on the CDC network and 
imported into a STARLIMS database for review of the patient data, statistical evaluation of the 
QC data, and approval of the results. See Error! Reference source not found. for a step-by-step 
description of how the analyst transfers data from the ICP-MS instrument computer to the 
laboratory information system (STARLIMS), reviews and documents the results in STARLIMS, and 
submits the results for review and approval. Request Helpdesk support for DLS STARLIMS issues 
using the link on the dashboard of DLS STARLIMS. 

D. Occasionally electronic files need to be deleted from the hard drive (i.e., for computer 
replacement or upgrade, to free up hard drive space, etc.). Verify the files have been transferred 
to the ISLE before deleting. Record action in the instrument logbook.  

  

Caution! 

All packages known to contain mercury-containing chemicals should be opened inside of a chemical 
fume hood. Chemical Fume Hood training should be taken every three years. Appropriate PPE is 
required when opening these shipments.  If a box containing any chemicals has physical damage, 

do not open the box. Notify either the lab chief, deputy branch chief, or branch chief to determine 
how to proceed. 
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4. Specimen Collection, Storage, and Handling Procedures; Criteria for Specimen 
Rejection 

Specimen handling conditions are outlined in the Division of Laboratory Sciences (DLS) Policies and 
Procedures Manual. The protocol discusses collection and transport of specimens and any special 
equipment required. If a specimen requires more than one test and needs to be divided, the 
appropriate amount of blood should be transferred into an appropriate cryovial labeled with the 
participant’s ID; avoid cross-contamination. 

A. Specimen type for this method is human whole blood.  

B. No special instructions such as fasting, special diets, etc. are required prior to specimen 
collection.  

C. All specimen collection devices and sample storage containers should be screened for total 
mercury contamination prior to use in the field and the laboratory. 

D. Collect whole blood specimens in pre-screened blood collection tubes. 

E. When focus of the study is metals, collect blood tubes for metals analysis first. Draw the blood 
through a stainless-steel needle into a pre-screened blood collection tube. 

F. Glass blood tubes cannot be frozen. Store blood specimens collected in glass tubes in a 
refrigerator (2°C to 8°C, setpoint 4°C). Specimens collected in the field are kept refrigerated (2°C 
to 8 °C, setpoint 4°C) for up to 1 week and then shipped by overnight carrier. 

G. Once received by DLS, they should be kept refrigerated during ‘in-processing’, which is typically 
completed within less than 4 hours and then stored in deep frozen conditions (range -50°C to -
90°C, set point typically -70°C) for up to 15 business days until they are transferred to the testing 
laboratory.  

• During ‘in-processing’ specimens are aliquoted into screened cryovials so they can be 
frozen. Long-term storage should be in deep frozen conditions (range -50°C to -90°C, set 
point typically -70°C).  

H. Once received by the testing laboratory sample aliquots can remain frozen until time for 
analysis. Portions of the sample that remain after analytical aliquots are withdrawn can be 
returned to deep frozen conditions (range -50°C to - 90°C, set point typically -70°C). 

I. Stability testing has been conducted (See Appendix A: Stability). Samples were stable for 24 
hours at ambient temperature (15°C to 30°C). Up to three freeze thaw cycles did not affect 
analyte recovery.  

J. The criteria for an unacceptable specimen are low volumes (< 0.4 mL), suspected contamination 
due to improper collection procedures or collection devices, and/or the presence of clots or 
microclots. Specimen contact with dust or dirt may compromise test results. In all cases 
mentioned above, request a second blood specimen.  
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5. Procedures for Microscopic Examinations; Criteria for Rejection of Inadequately 
Prepared Slides 

Not applicable to this method. 

6. Preparation of Reagents, Calibration (Standards), Controls, and All Other Materials; 
Equipment and Instrumentation 

A. Reagent Preparation 

Prepare all reagents with deionized water (DI H2O) with a resistance ≥ 18 MΩ∙cm. Though each 
reagent preparation specifies a total volume of reagent prepared, these directions may be 
scaled up or down to prepare larger or smaller quantities if desired. 

Label all reagent preparations in accordance with the Division Laboratory Safety Manual [15] 
and/or the DLS Joint Labeling Requirements. Specific storage conditions and expiration dates for 
reagents are listed below. To facilitate tracking of solvents and other chemicals transferred from 
the original manufacturer containment into a secondary container (e.g., solvent bottle), include 
the expiration date provided by the manufacturer or the lot number on the secondary 
container. 

(1) NaOAc Buffer Solution (0.1 M sodium acetate anhydrous) 

a) Dissolve 16.41 g of sodium acetate anhydrous into approximately 2000 mL of DI water in 
a 2000 mL polypropylene vessel with a magnetic stir bar on a magnetic stir plate, and 
mix thoroughly.  

b) Measure pH and adjust pH to approximately 4.75 with glacial acetic acid. Dilute to final 
volume with DI water. Store at room temperature. Expires one year from the date 
prepared.  

(2) Sodium tetra(n-propyl)borate (NaPr4B, 2% w/v) 

a) Place one unopened vial containing 5.00 g of sodium tetra(n-propyl)borate, a squirt 
bottle of DI water, and a clean 50 mL conical centrifuge tube filled with 10-20 mL of DI 
water inside a glove box or tent. Fully purge glove box or tent with 100% nitrogen for 
approximately 5 minutes to remove oxygen.  

b) Open the vial containing sodium tetra(n-propyl)borate and add 10-20 mL of DI water 
with constant swirling.  

c) Pour the dissolved contents into the 50 mL conical centrifuge tube. Wash the reagent 
vial with additional DI water to dissolve remaining solids and quantitatively transfer 
remaining reagent to the 50 mL tube. Cap the 50 mL tube and remove from tent. Once 
dissolved, the NaPr4B solution may now be safely used in normal atmosphere.  

d) Inside a chemical fume hood, quantitatively transfer reagent solution containing 5.00 g 
of NaPr4B to a 250 mL UV-resistant amber glass volumetric flask. Dilute to the final 
volume with DI water. This makes a 2% (w/v) NaPr4B solution. Store in refrigerator (2°C 
to 8°C, set point typically 4°C). Expires three weeks from the date prepared.  
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(3) 2% hydrochloric acid, 3% acetic acid and 1% methanol; used to prepare the working spike 
solution 

a) Fill a clean 50 mL polypropylene tube approximately half full with DI water  

b) Add 1mL of hydrochloric acid, 1.5mL of acetic acid and 0.5mL of methanol.  

c) Fill to the 50 mL mark with DI water. 

d) This solution will be discarded once the working solution is prepared.   

(4) Base blood pool screened for mercury 

Human blood with the lowest mercury content available must be used. Distribute base 
blood into pre-labeled 2 mL polypropylene cryovials in approximately 1.5 mL aliquots. 

B. Standards Preparation 

Exercise the utmost care in executing all measurements precisely to obtain the best accuracy for 
the final concentrations. 

Remove the vendor-supplied standard solutions of the following from cooled storage and allow 
to reach room temperature: Me201Hg, and Et198Hg ISC Science enriched isotopes. The following 
intermediate and working solutions are prepared gravimetrically allowing the final 
concentrations of “spike” material in the working solution to be determined by weight. An Excel 
worksheet was developed to calculate the final concentrations of working triple spike standards 
solution, and the template for the worksheet can be found in 0 Template for Working Triple 
Spike Standards Solution. 

(1) Intermediate standard solution 

a) Pipette 100 µL each of In199Hg, Me201Hg, and Et198Hg ISC Science standards into 
separately labeled 2 mL microcentrifuge tubes.  

b) Add 900 µL of DI water to each and mix thoroughly. (Note that the volumes pipetted 
depend on the concentrations of the original stock solutions.) 

c) These solutions will be discarded once the working solution is prepared. 

(2) Working solution (containing a mixture of three isotope standards): 

a) Fill a clean 50 mL volumetric flask approximately half full with the 2% hydrochloric acid, 
3% acetic acid and 1% methanol solution. 

b) Pipette 100 µL of each intermediate standard solution into the flask.  

Caution! 

Mercury compounds are toxic!  Take extra care to avoid accidental dermal contact, ingestion, or inhalation 
of these materials. Wear appropriate personal protective equipment. At a minimum, wear a laboratory coat, 

safety glasses, and latex or nitrile gloves. Clean up any spill that might occur according to applicable 
hazardous material spill procedures.   
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c) Discard the remaining intermediate standard solutions after the aliquots have been 
taken. 

d) Bring the volume to 50 mL with the solution prepared in the step b.1. above. (Note that 
the volumes pipetted depend on the concentrations of the original stock solutions). 

e) The concentration of each mercury isotope standard in the working solution will be 
within a range of 0.5–3 µg/L. Calculate the exact concentration of each isotope standard 
contained in the Working Triple Spike Standards Solution by using the Excel worksheet 
for spike calculation (see example in 0 Template for Working Triple Spike Standards 
Solution).  

f) Store in refrigerator (2°C to 8°C, set point typically 4°C). The working solution expires 
three weeks from the date prepared. 

C. Preparation of Quality Control Materials 

Quality control (QC) materials are prepared from pools of whole blood obtained from a donor 
source or purchased commercially.  The control "base" blood and two QC blood pools intended 
for the mercury speciation assay are designated as listed in Table 2 below where substitutions 
are: yy = the last two digits of production year and ### = assigned pool identification number. 
QC materials intended for bench quality control purposes need to be "characterized" as 
described in the section “Establish QC limits for each QC pool”. 

Order whole human blood from an appropriate vendor or use donated blood. Characterize for 
total Hg using this method or an equivalent method.  

Table 2 List of Prepared Quality Control Materials 

QC Level QC Designation ID 

Base pool BB-yy### 

Low pool LB-yy### 

High pool HB-yy### 

where substitutions are: yy = the last two digits of production year and ### = assigned pool 
identification number. QC materials intended for bench quality control purposes need to be 
"characterized" as described in the section “Establish QC limits for each QC pool”. 

Order whole human blood from an appropriate vendor or use donated blood. Characterize for 
total Hg using this method or an equivalent method. 

  

Caution! 
Mercury compounds are toxic!  Take extra care to avoid accidental dermal contact, ingestion, or inhalation 

of these materials. Wear appropriate personal protective equipment. At a minimum, wear a laboratory coat, 
safety glasses, and latex or nitrile gloves. Clean up any spill that might occur according to applicable 

hazardous material spill procedures. 
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(1) Preparation of bench low and high quality control pools  

Analyze purchased base blood for InHg, MeHg, and EtHg species. Assign blood bags into a 
“low” pool or to a “high” pool according to the concentration ranges that are needed. Add 
additional volumes of InHg, MeHg, and EtHg (not enriched) species to achieve the desired 
concentrations of each "low" and "high" pools. While constantly stirring each pool, aliquot 
approximately 1.5 mL of blood into a number of pre-labeled 2 mL vials. Prepare a quantity of 
vials that can be used for analytical runs over an extended period of time (at least 2 years 
but up to five years or longer if proven stable). Stability studies assessing long-term storage 
conditions of laboratory prepared quality control materials for this analytical method have 
been completed (see Appendix A: Stability). Store aliquoted QC material in deep frozen 
conditions (-50°C to - 90°C, set point typically -70°C). 

(2) QC pool homogeneity 

When a pooled QC material is prepared, an analytical run to assess the homogeneity of the 
pools is performed after the quality control pools have been aliquoted into individual vials. 
Vials are randomly chosen and randomly analyzed. The first and last vials dispensed are 
always included in the homogeneity study. Consult with a statistician about the appropriate 
design of your homogeneity study prior to dispensing the pool to ensure that sufficient 
statistical power is obtained. 

Unlike the characterization of the QC, the homogeneity study should be completed in a 
single analytical run. Once sample analysis is complete, the data is statistically evaluated to 
determine homogeneity. If the concentration of Hg species in each pool does not vary 
significantly from beginning to end or if problem vials can be identified and eliminated, the 
characterization of the QC is the next step. If problems exist, the source(s) of the problem 
has to be identified and remedied before pool characterization can begin. 

(3) QC pool characterization 

Characterization of each QC pool establishes statistical control limits for each pool. At least 
20 analytical runs are needed for a QC characterization. The preference for QC 
characterizations is that the characterization runs are distributed among all instruments that 
will be used to analyze the method. Ideally, all analysts that will run patient samples using 
the analytical method should complete some of the characterization runs. When available, 
previously characterized QC samples or pools with target values assigned by outside 
laboratories are also analyzed in QC characterization runs to evaluate each run. Once 
analysis of all characterization runs is complete, SAS is used to calculate the characterization 
statistics that will be used for the statistical evaluation of all future analytical runs. 

D. Other Materials 

Reagents and sources used with this method are listed below. Reagents used with 
implementation of the methodology must be equivalent to those listed below if procured from 
other sources. All chemicals and solvents are used without further purification. 

(1) Chemicals 

a) Deionized (DI) water, ≥18 MΩ cm resistivity. 
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b) Sodium acetate anhydrous, (CAS# 127-09-3), (C2H3NaO2--MW 82.04), (Millipore/Sigma, 
Milwaukee, WI), Item # 59929-100G-F, or equivalent.  

c) Glacial acetic acid, (CAS# 64-19-7), (CH3COOH--MW 60.05), reagent ACS grade (GFS 
Chemicals, Powell, OH), Item # 624, or equivalent. 

d) Double-distilled Hydrochloric Acid, (CAS# 7647-01-0), (HCl-MW 36.461--37.0%--12.1M) 
(GFS Chemicals Inc.), Item # 2180, or equivalent. 

e) Double-distilled Nitric Acid (CAS# 7697-37-2), (HNO3-MW 63.013-70.0%--15.8M), (GFS 
Chemicals Inc.), Item # 621, or equivalent. 

f) Methanol HPLC Grade (CAS#67-56-1), (CH3OH-MW 32.04), (GFS Chemicals Inc.), Item 
#2483, or equivalent. 

g) Sulfuric Acid, (CAS# 7664-93-9), (H2SO4-MW 98.08), (Fisher Scientific, Suwanee, GA), 
Trace Metal grade, item # A510-P500, or equivalent. 

h) Hydrogen Peroxide, 30% solution, stabilized (CAS# 7722-84-1), (H2O2, MW 34.0), (EMD 
Millipore, Germany), item #386790, or equivalent. 

i) Tetramethylammonium hydroxide, 25% w/w in water (CAS# 75-59-2), (C4H13NO-MW 
91.15), (Alfa Aesar, Ward Hill, MA), Item # 20932, or equivalent. 

j) Sodium tetra(n-propyl)borate, (CAS# 45067-99-0), (NaPr4B -MW 206.16), (ABCR, 
Germany), Item # AB135075-0005.00-GRM or (VHG Labs, Manchester, NH) Item # DE-
MS-03410-5), or equivalent. 

k) Broad spectrum disinfectant, Fisher Scientific, Item # 19-130-5977, or equivalent 
disinfecting agent. 

l) Certified pH 4 and pH 7 buffer solutions, (Fisher Scientific), Item # SB115-500 and 
SB107-500, or equivalent. 

m) Base whole blood with EDTA, Tennessee Blood Services, equivalent vendor, or donated.  

n) NIST SRM 955d - Toxic Metals and Metabolites in Frozen Human Blood (NIST, 
Gaithersburg, MD), or equivalent.  

o) Xenon gas, 100ppm (Airgas South), Item # X02HE99C350002, or equivalent. 

p) Nitrogen gas, Ultra High Purity (UHP) (Airgas), Product # NI UHP300, or equivalent. 

q) Helium gas, Research grade (Airgas), Product # HE R300, or equivalent. 

(2) Isotope Dilution Standards 

a) 198Hg-Enriched Ethyl mercury (CH3CH2
198Hg), (Innovative Solutions in Chemistry S.L. or 

ISC Science), Item # IES-EtHg198 or equivalent 

b) Hg standard solution enriched in 199Hg (199Hg), (Innovative Solutions in Chemistry S.L.), 
Item # IES-Hg199 or equivalent 
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c) 201Hg-enriched Monomethylmercury (CH3
201Hg), (Innovative Solutions in Chemistry S.L.), 

Item # IES-MMHg201 or equivalent 

(3) Lab Supplies 

a) Gas regulators for argon, helium, xenon, and nitrogen (Airgas, Atlanta, GA) or equivalent 

b) Captair pyramid glove bag (Model 2200 A, Erlab, North Andover, MA, item # EW-33666-
50), size XL or equivalent 

c) Peristaltic pump tubing for sample and internal standard (0.76 mm i.d.), Item # 
N8145202, and for waste (3.16 mm i.d.), Item #N8122012 or equivalent 

d) Fomblin®GV80 pump fluid for the roughing pump, Item # N1845003 or equivalent 

e) NexION® Trap Coaxial Foreline, Item # W1036511 or equivalent 

f) PE Sciex Coolant, Item # WE016558A or equivalent 

g) 0.5-200 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation, Item # LH-
L790200, or equivalent 

h) 5-350 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation, Item # LH-
L790350, or equivalent 

i) 10-1000 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation, Item # LH-
L791000, or equivalent 

j) 5 mL pipette tips, 1000 tips per case, Sartorius Corporation, Item # 780308, or 
equivalent 

k) 50 mL combitips plus, 100 tips per case (Eppendorf® catalogue # 02226660-8), or 
equivalent 

l) 10 mL combitips plus, 25 tips per case (Eppendorf® catalogue # 02226650-1), or 
equivalent 

m) 2.5 mL combitips plus, 100 tips per case (Eppendorf® catalogue # 02226630-6), 
Westbury NY), or equivalent 

n) 50-mL acid-cleaned volumetric flasks for triple spike solution preparation 
(polypropylene or Teflon™ flasks preferred). To acid-wash flasks, rinse with 1.2 M 
hydrochloric acid followed by rigorous rinsing with DI water. Repeat this process several 
times depending on prior use of the containers. 

o) 250-mL acid-cleaned volumetric flasks (UV-resistant) for derivatizing reagent (NaPr4B) 
preparation (polypropylene or Teflon™ flasks preferred). To acid-wash flasks, rinse with 
1.2 M hydrochloric acid followed by rigorous rinsing with DI water. Repeat this process 
several times depending on prior use of the containers. 
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p) Acid-cleaned 1 L PE bottles for buffer solution preparation. To acid-wash flasks, rinse 
with 1.2 M hydrochloric acid followed by rigorous rinsing with DI water. Repeat this 
process several times depending on prior use of the containers. 

q) 50 mL polypropylene tubes pre-screened for Hg (Fisher Scientific), Item # 14-432-22, or 
equivalent. 

r) 15 mL polypropylene tubes pre-screened for Hg (VWR), Item # 82050-276, or 
equivalent. 

s) 2 mL Safe-Lock® polypropylene (PP) microcentrifuge tubes, Eppendorf® Item # 
022363352, (Fisher Scientific, Suwanee, GA), or equivalent.  

t) Eppendorf® tube racks for 2 mL microcentrifuge tubes, Item # 05-405-3, (Fisher 
Scientific, Suwanee, GA), or equivalent.  

u) Blue racks for 2 mL cryovials (50-vial capacity), Item # 03-375-24L, (National Scientific), 
or equivalent. 

v) Four or more PAL3 sample rack for 60 vials of 20 mL, Item #PAL3-Rack-R60, (CTC 
Analytics), or equivalent. 

w) PAL DHR autosampler vials 20 mL, glass, Item # 16-2000, (Microliter Analytical Supplies, 
Inc.), or equivalent. 

x) Head space caps for 20 mL glass vials, Item # 16-0050M, (Microliter Analytical Supplies, 
Inc.), or equivalent. 

y) Kay-Dry™ paper towels and Kim-Wipe™ tissues, Item # 06-666-11, (Fisher Scientific, 
Suwanee, GA), or equivalent. 

z) Teflon™-coated magnetic stirs bars (4), Item # 58948-974, (VWR Scientific, Buffalo 
Grove, IL), or equivalent. 

aa) Teflon™-coated magnetic stirs bars, Item # 58947-140, (VWR Scientific, Buffalo Grove, 
IL), or equivalent. 

bb) Sharps containers, 8.2 qt., pack of 12, Item # 14-826-128, (Fisher Scientific, Suwanee, 
GA), or equivalent. 

cc) Cotton swabs (Hardwood Products Co. ME), or equivalent. 

dd) Nitrile, powder-free examination gloves (VWR or Fisher Scientific), or equivalent. 

ee) Biohazard autoclave bags (Fisher Scientific), or equivalent. 

ff) Heavy wall 12x75 mm borosilicate glass test tubes (Fisherbrand catalog #: 14-958-10B) 
or equivalent. 

gg) Position WEFLON-PTFE sample rack (Catalog #: UC85034) Milestone, Shelton, CT or 
equivalent. 

Mercury:  Inorganic, Ethyl, and Methyl - Blood 
NHANES August 2021 - August 2023

14 of 91



 

hh) 5-350 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation, Item # LH-
L790350, or equivalent 

ii) 10-1000 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation, Item # LH-
L791000, or equivalent 

jj) 5 mL pipette tips, 1000 tips per case, Sartorius Corporation, Item # 780308, or 
equivalent 

kk) 50 mL combitips plus, 100 tips per case (Eppendorf® catalogue # 02226660-8), or 
equivalent 

ll) 10 mL combitips plus, 25 tips per case (Eppendorf® catalogue # 02226650-1), or 
equivalent 

mm) 2.5 mL combitips plus, 100 tips per case (Eppendorf® catalogue # 02226630-6), 
Westbury NY), or equivalent 

nn) 50-mL acid-cleaned volumetric flasks for triple spike solution preparation 
(polypropylene or Teflon™ flasks preferred). To acid-wash flasks, rinse with 1.2 M 
hydrochloric acid followed by rigorous rinsing with DI water. Repeat this process several 
times depending on prior use of the containers. 

oo) 250-mL acid-cleaned volumetric flasks (UV-resistant) for derivatizing reagent 
(NaPr4BNaPr¬4B) preparation (polypropylene or Teflon™ flasks preferred). To acid-wash 
flasks, rinse with 1.2 M hydrochloric acid followed by rigorous rinsing with DI water. 
Repeat this process several times depending on prior use of the containers. 

pp) Acid-cleaned 1 L PE bottles for buffer solution preparation. To acid-wash flasks, rinse 
with 1.2 M hydrochloric acid followed by rigorous rinsing with DI water. Repeat this 
process several times depending on prior use of the containers. 

qq) 50 mL polypropylene tubes pre-screened for Hg (Fisher Scientific), Item # 14-432-22, or 
equivalent. 

rr) 15 mL polypropylene tubes pre-screened for Hg (VWR), Item # 82050-276, or 
equivalent. 

ss) 2 mL Safe-Lock® polypropylene (PP) microcentrifuge tubes, Eppendorf® Item # 
022363352, (Fisher Scientific, Suwanee, GA), or equivalent.  

tt) Eppendorf® tube racks for 2 mL microcentrifuge tubes, Item # 05-405-3, (Fisher 
Scientific, Suwanee, GA), or equivalent.  

Blue racks for 2 mL cryovials (50-vial capacity), Item # 03-375-24L, (National Scientific), 
or equivalent. 

uu) Head space caps for 20 mL glass vials, Item # 16-0050M, (Microliter Analytical Supplies, 
Inc.), or equivalent. 

vv) Kay-Dry™ paper towels and Kim-Wipe™ tissues, Item # 06-666-11, (Fisher Scientific, 
Suwanee, GA), or equivalent. 
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ww) Teflon™-coated magnetic stirs bars (4), Item # 58948-974, (VWR Scientific, 
Buffalo Grove, IL), or equivalent. 

xx) Teflon™-coated magnetic stirs bars, Item # 58947-140, (VWR Scientific, Buffalo Grove, 
IL), or equivalent. 

yy) Sharps containers, 8.2 qt., pack of 12, Item # 14-826-128, (Fisher Scientific, Suwanee, 
GA), or equivalent. 

zz) Cotton swabs (Hardwood Products Co. ME), or equivalent. 

aaa) Nitrile, powder-free examination gloves (VWR or Fisher Scientific), or 
equivalent. 

bbb) Biohazard autoclave bags (Fisher Scientific), or equivalent. 

ccc) Heavy wall 12x75 mm borosilicate glass test tubes (Fisherbrand catalog #: 14-958-10B) 
or equivalent. 

ddd) Position WEFLON-PTFE sample rack (Catalog #: UC85034) Milestone, Shelton, CT 
or equivalent. 

E. Instrumentation 

Analytical instruments used with this method are listed below. Before a product substitution is 
made, equivalent performance of the substitute instrumentation (e.g., GC, ICP-MS) must be 
demonstrated experimentally in accordance with DLS Policies and Procedures. Equivalent 
performance must also be demonstrated in accordance with DLS policies and procedures when 
multiple analysis systems are used in parallel, even if they are of the exact same type, however 
currently only one analytical system is used in the lab. 

(1) Inductively-coupled plasma mass spectrometer, specifically, the NexION® 300D ICP-Mass 
Spectrometer with Universal Cell Technology (UCT™) and Dynamic Reaction Cell (DRC™) 
capability, PerkinElmer® LAS or equivalent 

(2) NexION® 300D ICP-MS Detector, Item # N8145000 or equivalent  

(3) Chiller 1 HP 230V/60HZ TP Quiet, PolyScience, Item # N0772046 or equivalent 

(4) Gas Chromatograph, PerkinElmer® Clarus 500 or 580 or equivalent system  

(5) GC capillary column, PerkinElmer® Elite-5 30 m, 0.25 mm i.d., 0.25 mm film thickness, Item 
# N9316076 or equivalent 

(6) GC-ICP-MS Heated Transfer Line accessory, Redshift®, Item # N0777440 for 115V or Item # 
N40777361 for 230V or equivalent 

(7) Solid Phase Micro Extraction (SPME) Fiber Assembly, specifically, Supelco Analytical 100µm 
Polydimethylsiloxane (PDMS) Coating (Red - Pack of 3), Supelco Analytical, Bellefonte, PA, 
Item # 57301 or equivalent 
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(8) “T” union to interface GC column to transfer line and make-up gas, Redshift® Item # 
TL00402 or equivalent 

(9) Thermogreen® LB-2 Septa, Supelco, Item # 20654 or equivalent 

(10) Glass inlet liner, Supelco, Item # 2631405 or equivalent 

(11) Graphite ferrule, 1/16 in x 0.5 mm for use with 0.32 i.d. transfer line, pkg. of 10, 
PerkinElmer®, Shelton, CT, Item # 09903700 or equivalent 

(12) Robotic Liquid Sample Processing Workstation: PAL® DHR dual head system, Trajan 
Scientific Americas, Inc. Item# DHR419084/DHE419085, or equivalent system Figure 1. The 
Dual Head SPME PAL® 3 Series II sample processing workstation, mounted on top of the GC 
features two (2) computer-controlled SPME fiber injection heads that run on a dual rail 
system. The two SPME Heads are independently controlled and perform SPME fiber 
equilibration/injection operations in tandem. 

 

 

Figure 1 Dual Head SPME Processing Workstation 

The Dual Head SPME PAL® 3 Series II sample processing workstation, mounted on top of the GC 
features two (2) computer-controlled SPME fiber injection heads that run on a dual rail system. 
The two SPME Heads are independently controlled and perform SPME fiber 
equilibration/injection operations in tandem. 
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F. Equipment 

Materials and supplies for use with this method are listed below. Items can be obtained from 
the following sources, or any equivalent source. In the case of simple laboratory 
instrumentation (e.g., pipettes, vortex mixer, analytical balance, etc.) a product listed herein 
may be substituted with an equivalent product from a different manufacturer provided if it 
meets or exceeds the specifications of the product listed. 

(1) Water purification system for providing ultrapure water with a resistivity ≥18 MΩ cm, Aqua 
Solutions, Jasper, GA, or equivalent. 

(2) High-precision analytical balance capable of accurately weighing milligram amounts of 
material to the tenth of a milligram or better, Mettler XP205 Delta Range Excellence Plus 
(Mettler Toledo), or equivalent 

(3) A pH meter with one hundredth's of a pH unit readout or better, Accumet XL-150, or 
equivalent. 

(4) Calibrated hand-held adjustable pipettes that cover the range of accurate liquid delivery 
from 50 µL to 5000 µL. Sartorius Picus NxT, Sartorius Corporation, single channel electronic 
programmable pipettes, or equivalent 

(5) Eppendorf® Repeater Xstream Pipette, Item #13-683-506, (Fisher Scientific), or equivalent 

(6) Vortex mixer, VWR, Item # 945303, or equivalent 

(7) Mechanical convection oven (FREAS Model 605, Thermo scientific, Item # 3166188), or 
equivalent 

(8) Microwave Digestion System (UltraCLAVE, Milestone Inc, Shelton, CT, item # 70540-UC4) or 
equivalent 

(9) Class II Biological Safety Cabinet (SterilGARD® III Advance, The Baker Company), Serial # 
82774, or equivalent 

(10) Chemical Fume Hood (Mott Manufacturing Ltd, Brantford, ON, Canada), Model # 7421000, 
Serial # 21126, or equivalent 

(11) Autosampler probe assembly, Item # B3000161 or equivalent 

(12) NexION cyclonic spray chamber, Item # N8145013 or equivalent 

(13) Demountable quartz torch, Item # N8122006 or equivalent 

(14) Torch o-ring kit, Item # N8120100 or equivalent 

(15) Torch alignment tool, Item# WE015554 or equivalent RF load coil, Item # WE021816, or 
equivalent 

(16) Quartz injector 1.2 mm ID, Item # N0681631 or equivalent  

(17) Quartz ball injector 2.0 mm ID, Item # WE023948 or equivalent 
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(18) Cone removal tool, Item # W1034694 or equivalent 

(19) NexION® platinum sampler cone, Item # W1033614 or equivalent 

(20) NexION® platinum skimmer cone, Item # W1026907 or equivalent 

(21) NexION® aluminum hyper skimmer cone, Item # W1033995 or equivalent 

(22) NexION® Sampler gasket, Item # W1040148 or equivalent 

(23) NexION® Hyper Skimmer o-ring, Item # 09902123 or equivalent 

(24) NexION® Hyper Skimmer Screw, Item # WE027484 or equivalent 

(25) NexION® Exhaust Filter Kit SV40BI, Item # N8145005 or equivalent 

(26) TQ+ Quartz nebulizer, Meinhard, Item # TQP-50-A0.5 or equivalent 

(27) Nebulizer connection kit, Meinhard, Item # F1-C16 or equivalent 

(28) UltraCLAVE Metal O-ring, Milestone, Shelton, CT, Item # WZ00046 or equivalent 

(29) UltraCLAVE Flat O-ring, Milestone, Shelton, CT, Item # OR0001 or equivalent 

(30) Four or more PAL3 sample rack for 60 vials of 20 mL, Item #PAL3-Rack-R60, (CTC Analytics), 
or equivalent. 

(31) PAL DHR autosampler vials 20 mL, glass, Item # 16-2000, (Microliter Analytical Supplies, 
Inc.), or equivalent. 

G. Computer Software 

(1) NexION® instrument control and data handling software, version 1.5 or greater must be 
installed on the computer controlling the NexION® 

(2) Chromatography data handling software, specifically, TotalChrom™ Workstation, version 
6.3.1 or later (PerkinElmer® Instruments, Shelton CT). Install PerkinElmer's TotalChrom™ 
Workstation package on the same computer containing the NexION® Instrument Control 
software*. Contact  

(3) PerkinElmer for installation and configuration of TotalChrom™. Alternatively, consult the 
TotalChrom™ Workstation User's Guide. This method assumes that version 6.3.1 of 
TotalChrom™ Workstation package is installed 

(4) Operating software for PAL DHR autosampler, specifically, Chronos (CTC Analytics AG, 2010 
- 2017)  

(5) ChromLink™ 3.5 software (PerkinElmer Instruments). The installation of ChromLink™ is 
straightforward when using the supplied installation utility 

(6) pdFactory Pro (FinePrint Software, LLC, www.fineprint.com) or equivalent software. This 
product is used for creating electronic Portable Document Files (pdf) directly from any 
Windows® compatible application print dialog box 

Mercury:  Inorganic, Ethyl, and Methyl - Blood 
NHANES August 2021 - August 2023

19 of 91



 

(7) A custom Microsoft Excel® macro procedure named "Extract TC Data" 

 

7. Calibration and Calibration Verification Procedures 

A. Method Calibration 

(1) Triple spike isotope dilution (TSID) is a particular useful technique that quantifies species 
transformations, allowing the analyst to calculate the concentrations of each species 
without the use of an external calibration curve [9]. Central to TSID design is a “spike” 
solution containing a mixture of three mercury species standards, each synthesized to be 
enriched with different isotopes of mercury (199HgCl2, CH3

200HgCl and C2H5
201HgCl), and 

must be added to each patient sample and equilibrated before mercury transformation 
reactions occur. Since the spike is chemically identical to the native form of mercury 
species contained in the sample, chemical transformations can be measured and 
mathematically corrected [10, 11]. The TSID methodology offers major improvements in 
accuracy, precision and LOD over standard calibration curves. 

(2) ICP-MS intensity signals of the three mercury species (iHg, MeHg and EtHg) are measured 
at m/z 198, 199, 200, 201 and 202. The 198Hg/202Hg, 199Hg/202Hg, 200Hg/202Hg, and 
201Hg/202Hg peak area ratios are calculated and exported into a Microsoft Excel spreadsheet 
originally developed by Ouerdane and colleagues [12-14] where a deconvolution algorithm 
mathematically corrects for mercury species interconversions. Mercury species 
concentrations are calculated using these isotope dilution equations. Isotopic impurities 
associated with isotopically enriched mercury standards, provided in ISC certificate of 
analysis, are included in calculating final mercury concentrations.  

(3) Calibration verification is not performed with this method because it uses the isotope 
dilution method that does not use an external calibration. 

(4) We participate in an internal proficiency testing (PT) program for Hg speciation for all three 
Hg species because no external PT program exists. Five samples are analyzed two times per 
year and submitted to an internal QA department. Additional details about the 
administration of internal PT programs can be found in the Internal Proficiency Testing SOP 
(IRAT-OC-QA.01.01).  

• Records of PT performance are signed by a Technical Supervisor and stored in the LIMS. 

B. Instrument Calibration 

(1) ICP-MS - The calibration of the ICP-MS is performed annually as part of a preventative 
maintenance program and performed by a qualified service engineer.  

• Preventative maintenance records are stored in the LIMS.  

(2) GC - The GC system is serviced annually as part of a preventative maintenance program and 
performed by a qualified service engineer.  

• Preventative maintenance records are stored in the LIMS.  

Mercury:  Inorganic, Ethyl, and Methyl - Blood 
NHANES August 2021 - August 2023

20 of 91



 

(3) Handheld pipettes - Pipette calibration verification is performed every six months using a 
certified volume verification system. If a calibration verification fails, the pipette is sent to 
the vendor for service and calibration. 

• Calibration and calibration verification records are stored in the LIMS.  

(4) Diluter (e.g., Hamilton Microlab 625) – Diluter calibration verification is performed annually 
by the vendor or qualified service engineer. If a calibration verification fails, the diluter is 
sent to the vendor for service and calibration. 

• Calibration and calibration verification records are stored in the LIMS. 

(5) pH meter - pH meters are shipped to the vendor every year for calibration. Calibration 
verification is performed by the analyst prior to use with commercial calibration solutions.  

• Vendor calibration records are stored in the LIMS.  

• pH calibration verification records are stored in the equipment notebook.  

(6) Balance - Balances are calibrated annually by the vendor or qualified service engineer. 
Calibration verification is performed by the analyst prior to use with certified weights.  

• Vendor calibration records are stored in the LIMS.  

• Balance calibration verification records are stored in the equipment notebook. 

(7) UltraCLAVE Microwave Digestion - The Microwave Digestion system is serviced annually as 
part of a preventative maintenance program and performed by a qualified service 
engineer.  

• Preventative maintenance records are stored in the LIMS. 

(8) Convection Oven - Convection Oven system is serviced annually as part of a preventative 
maintenance program and performed by a qualified service engineer.  

• Preventative maintenance records are stored in the LIMS. 

8. Procedure Operating Instructions; Calculations; Interpretation of Results  

A. Preliminaries 

(1) Launch the NexION® ICP-DRC-MS software and note whether all graphical indicators of 
instrument readiness are green. If not, take the appropriate actions described in the 
instrument's software and hardware manual.  

(2) Perform necessary instrument function checks as listed on the electronic instrument 
performance log sheet. Note the base vacuum pressure in the INSTRUMENT window of the 
software. (Before igniting the plasma, the vacuum is typically about 8 x 10-6 torr). Keep a 
record of any maintenance procedures along with the base vacuum pressure in the 
electronic instrument performance log sheet.  
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(3) In the INSTRUMENT window of the NexION® software, click the "Front Panel" tab and click 
the plasma "Start" button to ignite the plasma. In the same window, the ignition sequence 
bar (blue progress bar) will start to expand from the right, indicating the approximate time 
before plasma ignition. The plasma may at first flicker, but it will stabilize after 5-10 
seconds.  

• On a rare occasion, the plasma may ignite emitting an orange, violently flickering light, 
and electrical discharge noises will be heard. In this case, immediately shut off the 
plasma by pressing the shutoff button on the front panel of the instrument. Wait 30 
seconds then investigate the cause of the plasma misfire. A more common occurrence is 
that the plasma may extinguish itself a few seconds after ignition. Promptly reignite by 
pressing the "Start" button on the ICP-DRC-MS instrument's front control panel. Usually, 
the plasma will stay lit after the second try. If not, investigate the cause of the plasma 
instability (refer to the NexION® Hardware Guide).  

(4) Set the GC analytical run parameters to what is listed in Error! Reference source not 
found.. Refer to the Clarus 580 User Guide for programming specifics. One or more 
parameters specified in Error! Reference source not found. may be changed, if determined 
necessary, to meet analytical performance goals. 

Table 3 GC Settings 

Parameter Setting 

GC injector Temperature Step #1: 1 min @ 220°C  
Step #2: linear ramp to 280°C, hold 

Carrier gas flow rate (Helium) 2 mL/min  

 Total flow ratio 28:1 @ 0.25 min 

Oven Temperature Step #1: 1 min @ 75°C 
Step #2: linear ramp to 250°C (at a 
rate of 45°C/min) 

Optimization gas flow rate (Xenon) 0.25 mL/min 

Transfer line Temperature (Aux - auxiliary zone) 250°C 

(Aux - auxiliary pneumatics) OFF (all) 

 

(5) After successful ignition and the instrument has warmed up and stabilized, perform the 
optimization of both plasma and mass spectrometer parameters of the ICP-MS by using a 
mixture of xenon (Xe) in argon (Ar). The ICP-MS system is optimized with Xe gas because of 
its similarities in ionization potential to Hg. 

a) Set the flow rate of the Xe gas mixture (100 ppm Xe in Helium) to approximately 0.25 
mL/min on the GC main display soon after plasma ignition to achieve Xe intensity of > 
100,000 cps (counts per second). In the NexION® software, upload "Xe Torch 
Alignment.mth". After the gas signal stabilizes, in the "Sample" window press "Analyze 
Sample" in "manual" mode. Perform X-Y optimization to obtain the highest possible Xe 
intensity (at least >100,000 cps). Proceed with the following steps to optimize other 
parameters in Error! Reference source not found. for maximum Xe intensity. 
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b) If X-Y optimization does not achieve Xe intensity of > 100,000 cps, advanced instrument 
optimizations can be performed, e.g., axial field voltage or deflector voltage.  

c) Save the optimized file as "Default.dac". The current optimized values will appear 
automatically and will be similar to the ones in Error! Reference source not found..  

Table 4 NexION® Optimization Parameters 

Parameter  Setting  Parameter  Setting  

Nebulizer Gas Flow (NEB):  1.5  RPa  0  

Auxiliary Gas Flow:  1.2†  RPq  0.3†  

Plasma Gas Flow:  15†  Cell Gas A  0.5†  

ICP RF Power:  1450  Cell Gas B  0  

Analog Stage Voltage:  -1950†  DRC Mode NEB  1.5  

Pulse Stage Voltage:  950†  DRC Mode QRO  - 16.90†  

Quadrupole Rod Offset Std  0  DRC Mode CRO  - 1.90†  

Cell Exit Voltage  -25†  DRC Cell Exit Voltage  -4.25†  

Cell Entrance Voltage  -25†  DRC Cell Entrance 
Voltage  

-4.25†  

Deflector Voltage  -13†  DRC Deflector Voltage  -13†  

Discriminator Threshold  17†  Axial Field Voltage  150†  
†Suggested starting values only. Optimum parameters will depend on the outcome of the optimization 
procedure.   

 

(6) PAL DHR is initially set up and optimized by service engineers, or other trained personnel. 
The settings can be optimized according to analyst needs (refer to PAL system user 
manual). The following procedures present the key steps that are taken to set up the PAL 
DHR autosampler system for this method.  

a) In the PAL control terminal, parameters for X, Y, Z positions of reference point, vial # 1, 
10, 60, and GC injection portal can be viewed under “User Level” (default mode). To 
select a highlighted item, press the central knob (ENTER button). Then use the outer 
knob to scroll through available options for that item or to change a numeric value. 
Then press the inner knob again to ENTER the displayed option.  

b) To calibrate the PALtool head alignment, using the PAL control terminal, press left and 
right “—” button at the same time to access “Extended User Level”. Under the main 
menu, select the SPME that needs to be calibrated then press ”ENTER”; open Options 
menu, select “Calibrate PALtool” press “ENTER”. Go to “Next”, the screen will direct 
user to move the PALtool manually to the reference point and press “Save” to save the 
X, Y, Z positions. In the main menu, scroll to the Tray Holder that need to be calibrated, 
press “ENTER”; select “Slot 1”, “Rack 1”, and then open Option menu, select “Teach 
PALmodule”; confirm the Robert Arm (Left for Tray 1, Right for Tray 2), press “Run”. The 
control panel will direct user to move the head to the teach point (vial position 1, 10,and 
60). Press “Save” after finishing each step to save the X, Y, Z positions. 

c) To calibrate the X, Y, Z positions of GC injection portal, scroll to “Injector 1” in the main 
menu press “ENTER”; then open Options menu, select “Teach PALmodule”; select Robot 
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Arm (Left or Right), press “Run”. The control panel will direct user to move the head to 
the teach point (i.e., GC injection portal) and press “SAVE” to save the X, Y, Z 
positions.to optimize X, Y, Z position. 

(7) PAL DHR is operated by Chronos software. Click on the Chronos icon on the operating 
computer desktop. Chronos method files used for this method can be accessed through 
clicking on "Method editor" on the Main Menu of Chronos. Click on the "Load" tab on the 
left which allows the analyst to upload the needed method file. There are three method 
files used in this method: PAL3_DHR_Bakeout.cam, PAL3_DHR_Conditioning.cam and 
PAL3_DHR.cam. The settings can be changed by the analyst for better separation and 
analytical response. 

a) Cleaning the SPME fiber is done at least every ten runs (see Section 8.B on Ten run 
maintenance) To clean SPME fibers PAL3_DHR_Bakeout.cam is used. Use sample lists 
SPME Bakeout LEFT.csl and SPME Bakeout RIGHT.csl for left and right fibers 
respectively. The settings are as shown in Table 5. 

• Record SPME fiber cleaning in electronic instrument log sheet 

Table 5 Chronos Settings (Baking) 

Parameter Setting 

Bakeout Time  420 s 

GC Runtime + Cooling Down  120 s 

Needle Penetration inlet 48 mm 

 

b) If a new SPME fiber is installed it will need to be conditioned; use - 
PAL3_DHR_Conditioning.cam and sample lists SPME Conditioning LEFT.csl and SPME 
Conditioning RIGHT.csl for left and right fibers respectively. The settings are as shown in 
Table 6.  

• Record SPME fiber replacement in electronic instrument log sheet 

 

Table 6 Chronos Settings (Conditioning) 

Parameter Setting 

Bakeout Time  1800 s 

GC Runtime + Cooling Down  120 s 

Needle Penetration inlet 48 mm 

 

c) To perform a run, the file “PAL3_DHR.cam” is used. The corresponding sample list is 
“PAL3_DHR.csl”. The settings are as shown in Table 7. 
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Table 7 Chronos Parameter Settings (for Run) 

Parameter Setting 

Source Tray Tray Holder 1:Slot1 

Vial 1,1; 2,2; 3,3 etc. 

Enrichment Time 1200 s 

Desorption Time 420 s 

GC Cooling Down 180 s 

Needle Penetration vial 38 mm 

Fiber Exposure 12 mm 

Needle Penetration inlet 48 mm 

 

(8) After optimization for maximum Xe intensity, navigate to the folder 
"C:\NexIONdata\Method" and click on the "Xe DRC Daily.mth" file then click the "Open" 
button. Record this data in the instrument logbook. 

(9) Complete the performance check before starting analytical run. 

(10) Fill in the performance log /maintenance log to record to the completed any optimization 
procedures. If a tuning (mass-calibration) procedure was done, save it to the file 
"default.tun," and also in a separate file containing the analysis date 
"default_MMDDYY.tun" (where MM=month, DD=day, and YY=year). 

(11) Samples and QC Material 

a) Identify, gather, and thaw a predetermined number of sample tubes/vials containing 
the blood samples to be analyzed in a batch run.  

b) For each batch of samples run, thaw one tube of low and high bench QC (often 
identified as "LB-yyxxx" and "HB-yyxxx"; for explanation of nomenclature, see Quality 
Control Material section).  

c) Label the necessary number of 2 mL microcentrifuge vials or glass tubes with 
appropriate identification to ensure that they will be matched to their corresponding 
unknown samples and QC. Similarly, label an equal number of 20 mL SPME vials.  

d) Use the preparation procedure outlined in VII D to prepare blood samples and QC 
materials. 

e) Cap all autosampler vials with the proper fitting septum caps. 

(12) Creating the NexION® Sample Table ".sam" file 

a) If it is not already open, launch the NexION® program and in the window titled 
"Instrument Control Session", choose menu item "File" > "Review Files". Click the "New" 
button for "Dataset" which is the second item on the list. Navigate to the folder 
"C:\GC\Data\" and enter the file name "Hg<yymmdd>" where yy = the last 2 digits of the 
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current year, mm = the month, and dd = the date of run. Click the "Open" button. The 
new dataset folder has been created and is now active. Click "DONE" in the Review Files 
Window.  

b) Click on the tool bar icon that looks like three Erlenmeyer flasks. Choose "File" > '"New" 
on the menu bar. A new window will appear titled "Samples - [Untitled]". Click the 
"Batch" tab then click on the "Sample Template" button. A dialog box titled "Sample 
Template Data" will appear. Enter the information as given in Table 8. 

Table 8 Sample Template Data 

Parameter Setting 

Sample ID:  001_ <sample name>  

Measurement Action (*): Run Sample 

Method: Hg DRC.mth 

Sample type: Sample 

Wash Override (sec) 0 

 

c) Parameters not mentioned in Table 8 can be left blank.  

d) From the menu bar, choose "File" > "Save As" and save the file in the directory 
"C:\GC\Data\" using the name "Hg<yymmdd>.sam" where yy = last 2 digits of current 
year, mm = this month, and dd = date of run.  

e) It is a good idea to save a copy of this file as a template, thereby avoiding the need to re-
create it every time. 

B. Instrument Maintenance 

(1) Complete “10 run Maintenance” following completion of 10 analytical runs on the 
instrument (See Appendix E: Electronic Instrument Performance log sheets) 

a) Replace GC injector septum and glass liner.   

b) Examine SPME fibers for discoloration and missing parts of polymer layer. If not in good 
condition replace the SPME 

(2) If instrument is not passing Performance Check, perform visual check of torch, injector, RF 
coil, cones, column, and charcoal trap, replace if needed: 

a) Visually check the cleanliness of these components. Notate any cleaning / replacing of 
consumables in the maintenance logbook.  

b) Injector: If there are deposits on the inside of the injector, remove the injector and clean 
it with 1-5 % v/v nitric acid and a cotton swab. Alternatively, replace injector with a 
spare and clean the dirty one in an overnight soak in 5% v/v nitric acid (can be 
ultrasonicated, but is not typically necessary). 
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c) Torch: Check for melting, cracking, and cleanliness. If necessary, replace with a spare 
and soak overnight in 5% v/v nitric acid bath. If torch is only dirty, replacement / 
cleaning can be deferred to the next regular weekly maintenance day. 

d) RF coil: Check for excessive corrosion (flaking). Replace if necessary. 

e) Sampler and skimmer cones: Check for excessive buildup of matrix, cracking, or pitting. 
If necessary, replace dirty cones with clean spare cones and clean. 

f) Column edges: Check for jagged or burned edges. Perform capillary cutting if needed. 

(3) Replace the charcoal trap if degradation in instrument performance is seen.  

(4) Replace the GC column if chromatography is not performing well, peak degradation is 
apparent. 

(5) The instrument computer should be rebooted at least monthly. Verify ISLE and MUST drive 
backups monthly. 

• Record in the instrument electronic logbook on the Instrument Maintenance worksheet. 

(6) Record all maintenance of computer hardware or instrument control software in the 
instrument logbook. This includes disk defragmentation, software upgrades, software 
patches, etc. 

C. Preparing a Run 

(1) Each day, before samples are analyzed, aqueous blanks and a dilution of Low Bench QC 
must be analyzed to ensure that the instrument is functioning properly. Aqueous blanks 
are analyzed to ensure there is no contamination present in the reagents used to prepare 
patient samples. Dilute Low Bench QC sample to bring mercury species concentration 
levels in the QC close to the LOD values for mercury species of the analytical method. Then 
analyze the diluted Low Bench QC to test the sensitivity of the instrument. Prepare all the 
following using the same technique and supplies as samples, unless stated otherwise. 

a) Aqueous Blank 1. To prepare, add 275 µL of TMAH into a 20 mL vial. To each vial, add 
7.7 mL of NaOAc Buffer solution and 250 µL of derivatization reagent (NaPr4B). Cap the 
vial immediately and gently mix it. Aqueous blank 1 is ready to be analyzed.  

b) Aqueous Blank 2. To prepare, add 7.7 mL of NaOAc Buffer solution to each vial followed 
by adding 250 µL of derivatization reagent (NaPr4B). Cap the vial immediately and 
gently mix it. Aqueous blank 2 is ready to be analyzed. 

c) Diluted Low Bench QC. Depending on which concentration level of LB QC is available, 
this QC sample is diluted with base blood to achieve similar concentrations of mercury 
species as the method’s LOD values. Diluted LB QC sample is prepared, digested, and 
analyzed in the same manner as patient samples. 

(2) After SPME-GC-ICP-MS analysis of Aqueous Blanks and Diluted Low Bench QC are 
complete, open the Aqueous Blanks and Diluted Low Bench QC RAW files in TotalChrom™. 
Examine the Aqueous Blank chromatograph for possible indicators of contamination. Then 
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look at the Diluted Low Bench QC chromatogram. This chromatogram will have visible 
peaks for the mass 202 isotopes of MeHg, EtHg, and InHg. The integrated area under each 
mercury species peak has to be greater than 300 (arbitrary units), otherwise there may not 
be sufficient sensitivity and the instrument may need to be optimized (see weekly 
performance check section). 

• Update electronic instrument performance log sheet to indicate instrument 
sensitivity was sufficient for sample analysis. 

(3) Preparation of bench QC and unknown blood sample preparation  

a) Digestion method 1: Convection Oven 

1. Pipette 100 µL of blood samples into pre-labeled 2 mL Safe-Lock microcentrifuge 
tubes.  

2. Add 100 µL of Triple Spike Standards Solution. Recap and vortex each tube before 
continuing to the next tube.  

3. Add 500 µL of TMAH to all tubes. Cap and vortex.  

4. Place rack containing capped tubes in the convection oven set to 80 ± 3°C for ≥ 20 
hours. 

b) Digestion method 2: UltraCLAVE Microwave Digestion 

1. Pipette 100 µL of blood samples into pre-labeled 12x75 mm glass test tubes.  

2. Add 100 µL of Triple Spike Standards Solution. Vortex each tube before continuing 
to the next tube.  

3. Add 500 µL of TMAH to all tubes. Vortex gently. Optionally, cover the test tubes 
with ventilated microwave digestion caps. 

4. Refer to Appendix F: Operation of the UltraCLAVE Microwave Digestion System for 
the Mercury Speciation Analytical Method for instructions of usage of the 
UltraCLAVE for digestion of the samples and quality control materials 

c) Derivatization of the digested samples: 

1. Aliquot 275 µL of digested samples into pre-labeled 20 mL SPME headspace vials.  

2. Add 7.7 mL of 0.1M NaOAc Buffer Solution using the Eppendorf® Repeater Xstream 
followed by 250 µL of NaPr4B Derivatization Reagent. Cap the vial immediately and 
mix 

Caution! 

Work with open vials containing biological samples inside of a biological safety cabinet (BSC). Recap vials 
before removing them from BSC. Wear appropriate personal protective equipment (lab coat, safety glasses, 

and gloves). 
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D. Initiating a Run 

(1) Create the daily data folder in C:\GC\Data under the name Hgyymmdd (i.e., Hg110422) 

(2) Launch NexION® Instrument Control program if it is not already up. Do not launch or start 
any other programs at this time. 

(3) Check that the correct NexION® method is loaded and active in the window "Instrument 
Control Session". If it is not correct, load the correct Method file. Check under the Sampling 
tab that "Peristaltic pump under computer control" is unchecked, and the pull-down menu 
"Sampling" indicates "External".  

(4) Check that the correct Sample file in the window "Instrument Control Session" is active. If it 
is not correct, load the correct Sample file.  

(5) Load created dataset file "Hgyymmdd" 

(6) Enter sample names into the NexION® sample table 

a) Click on the tool bar icon that looks like three Erlenmeyer flasks. If the current Samples 
window is not this run's sample file, then choose "File" > "Open" on the menu bar and 
navigate to and open this run's current data folder in "C:\GC\Data\". Click on the file 
named "Hg<yymmdd>.sam" (yy = year, mm = digit month, dd = date) and open it. The 
Samples window will be the one created in the section creating the or NexION® Sample 
Table ".sam" file.  

b) Fill in the name of each sample by double-clicking after the "_" (underscore) in the cell 
"sample ID". Type in the sample name and press "Enter" on the keyboard. In this 
manner, enter the name of blanks, quality control, and samples that will be analyzed in 
the run. If barcodes are used on the sample labels, use the barcode scanner attached to 
the ICP-DRC-MS computer to scan the sample ID from the barcode on each sample 
before placing it into position in PAL DHR autosampler tray.  

c) Fill in the samples table in similar fashion to what is shown in  

d) Table 9 below. 
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Table 9 NexION® Sample Table 

A/S Loc. Batch 
ID 

Sample ID Measurement 
Action 

Method … Sample 
Type 

1  001_ Aq.Blk Run Sample hg drc.mth  Sample  

1  002_ Aq.Blk Run Sample hg drc.mth  Sample 

2  003_ Diluted LB Run Sample hg drc.mth  Sample 

2  004_ Diluted LB Run Sample hg drc.mth  Sample 

3  005_ LB-yyxxx Run Sample hg drc.mth  Sample 

3  006_ HB-yyxxx Run Sample hg drc.mth  Sample 

4  007_ Sample Run Sample hg drc.mth  Sample 

4  008_ Sample Run Sample hg drc.mth  Sample 

…rows for 18 samples and SRM material were omitted for brevity 

14  027_LB-yyxxx Run Sample hg drc.mth  Sample 

14  028_HB-yyxxx Run Sample hg drc.mth  Sample 

 

In the example table above, a run of 20 samples is shown so the last vial ends up being 
placed in A/S Location #16 (this location corresponds to autosampler location which is 
defined in Chronos, since there are two autosampler trays two #14 are used - "Left" and 
"Right". It is not necessary to put A/S loc in NexION® - only for the analyst’s benefit).  

The numbers preceding the underscore correspond to the order of injection. These 
numbers will later help the analyst find individual chromatograms based on injection 
number instead looking for specific sample names during post-run data processing in 
TotalChrom™. 

1. When the sample table entries are verified to be correct, choose "File" > "Save".  

2. Print the NexION® sample table by choosing the "File" > "Print Setup" > "Reports". 
In the ensuing dialog box, select the preferred printer and click "OK". Next, choose 
"File" > "Print" and then click the "Print" button. Refer to the printout of the 
NexION® sample table for the correct vial positions when loading samples into the 
PAL DHR autosampler tray.  

(7) Check that the GC methods are correctly programmed. 

(8) Check that PAL® DHR autosampler methods are correctly programmed.  

(9) This step offers the advantage that the NexION® data files will be converted in real time to 
TotalChom™.raw" files that have names containing a date-time stamp corresponding to the 
actual time of injection. 

a) Launch TotalChrom™ Navigator. In the resulting TotalChrom™ Navigator window, 
choose menu item "Apps" > "ChromLink™" (alternatively, you may launch ChromLink™ 
from the operating system "Start" > "Programs" menu).  
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b) In the ChromLink™ program window, choose the menu item "Configuration" > "Mass 
Details" and check the Nominal Name and Mass for mercury isotopes. If it is missing or 
the NexION® tune ("default.tun") file was re-optimized earlier then ChromLink™ needs 
to be configured (see Configuration of ELAN® ChromLink™ on page 38 for details). To 
save time, the analyst may choose to close the TotalChom™ Navigator and ChromLink™ 
windows and skip step 6 in its entirety. Data file conversion via ChromLink™ can easily 
be done during post-run data reprocessing. 

c) In the ChromLink™ program window, click on the "Browse" button just right of the 
"ELAN® ChromLink™ file location" field. Navigate to the current working folder, double-
click on it then click the "OK" button so that ChromLink™ knows where to save its 
processed files.  

d) Otherwise, refer to step (b) of Data Processing and Analysis on page 39 for details on 
proper setting of the ELAN® ChromLink™ window's parameter fields. In the ELAN® 
ChromLink™ window, click the button "Start Processing NexION® Data Files" to put 
ChromLink™ in watch mode so it will process each data for each injection in real time. A 
new dialog box will open and indicate it is ready to convert data and waiting for the first 
file. 

(10) Launch the Chronos program, which communicates with the PAL DHR autosampler and 
NexION® software. 

a) In the main menu, click on "Sample list" then upload analysis method for SPME fiber 
cleaning "baking".  

b) Upload "SPME Bakeout LEFT.csl" (to clean the left fiber) then select "Create" button in 
the Schedule section. The “Schedule and run control” window will appear with time 
intervals required for the measurement. Click "Start queue" on the top of the window to 
proceed with the fiber cleaning. 

c) Repeat step above to clean the right fiber and use "SPME Bakeout RIGHT.csl" 

d) After fiber cleaning and daily performance, check to ensure that the QC and samples are 
ready for analysis using SPME fibers. On the "Main Menu", select "Sample list" then click 
"Load" tab in the List submenu on the left. UploadPAL3_DHR.csl file. This file 
communicates with the left and right fibers. A table similar to the one below (Table 10) 
will appear. The table will have the Analysis Method ”C:\Users\NexION-
M\Documents\CDC PAL DHR419085\Methods\PAL3_DHR.cam" (NexION-M) and 
“C:\User\NexION-R\Documents\CDC PAL DHR419084\Methods\PAL3_DHR.cam” 
(NexION-R) uploaded.  

e) "Source Vial" column shows which autosampler position will be analyzed first. There are 
two racks (left and right) with vial positions 1 to 60. The left rack gets analyzed by the 
left SPME fiber and the right rack gets analyzed by the right SPME fiber. There are two 
numbers "1" in the source vial column. The first one always corresponds to left rack/left 
fiber. 

f) Chronos communicates to the autosampler through "source vial" position. The analyst 
has to make sure that the samples in NexION® correspond to the locations seen by 
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Chronos. For Example, if the analyst wants to analyze slots 1-5 on both racks (total of 10 
samples), highlight Row 1 through 10 in the sample list and click “Create” button in the 
Schedule section with “overlapped” option checked. The run schedule will appear in 
“Schedules and run control” on the Main Menu.  

Table 10 Chronos Samples Table 

Analysis Method Source 
Vial 

Enrichment 
Time (s) 

Desorption 
Time (s) 

GC cooling 
down (s) 

C:\Users\NexION-M\Documents\CDC PAL 
DHR419085\Methods\PAL3_DHR.cam* 

1 1200 420 180 

 1 1200 420 180 

 2 1200 420 180 

 2 1200 420 180 

Rows for source vials 3 to 59 are omitted 

 60 1200 420 180 

 60 1200 420 180 

 

(11) Check that the DRC gas is indeed flowing by making the NexION® instrument window active 
and clicking on the Diagnostics tab. Inspect the Cell Gas A or B whose value will be 
fluctuating around the current value ± 0.01 mL/min. If it is not, see section “Turning on the 
Reaction Cell Gas” for details on how to turn on the DRC gas.  

(12) Check that all blanks, QC, and sample vials are loaded into their correct positions in the PAL 
DHR autosampler trays as designated by the NexION® sample window and in the positions 
seen by Chronos.  

(13) As a reminder, before samples are analyzed, the daily performance check will be analyzed 
to ensure that the instrument is functioning properly.  

a) Click on the NexION® "Instrument Control Session" window to make it active. Highlight 
the samples and click the "Analyze Batch" button. A Run Progress box will appear 
indicating that the NexION® software is now awaiting a signal from Chronos that 
indicates the occurrence of an injection. 

b) In Chronos: to analyze samples, select "Create" button in the Schedule section, then 
click "Start queue" on the Schedule and run control window.  

c) View the chromatograms in TotalChrom™ and in the real time window of NexION® to 
ensure that there are no problems with the analysis. After the aqueous blanks and 
diluted LB been analyzed, the run can be started.  

(14) Open the NexION® "Instrument Control Session" Real-Time window by clicking the tool bar 
button that looks like a Gaussian distribution (the blue chromatographic peak). After the 
Real-Time window opens, click on the drop-down menu and select "Signal". Real-time data 
will now be displayed.  
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(15) The PAL® DHR autosampler will seek the first vial and make an injection. A blue bar in the 
NexION® progress box will now indicate that data is being collected. The system can now 
run unattended. 

(16) Check the progress of the run after 2 or 3 injections. Note the chromatograms appearing in 
the NexION® Real Time window. Adjust the signal scale in the Real Time window, as 
necessary. Compare the positions and peak heights of each mercury species. It helps to 
visually compare it to a printed reference chromatogram. If abnormalities in retention 
time, peak height, or peak shape are readily apparent, the analyst may need to stop the 
autosampler, abort the run in the Chronos program, and stop the NexION®. Correct the 
problem(s) and restart the run. 

E. Processing and Reporting a Run 

Refer to Figure 2 "Post-Run Data Processing Work Flow Diagram" for a summary representation 
of the important aspects of post-run data processing. 

(1) Open Microsoft Windows® File Explorer and open the current working GC data directory 
(e.g., C:\GC\Data\<current working folder>). Select all files ending with the .rst and .idx and 
"delete" them to the Microsoft Windows® Recycling Bin.  

(2) If it is not already open, launch TotalChrom™. 

(3) If ChromLink™ was not run in real-time data collection mode during the run then do the 
following:  

a) In the TotalChrom™ Navigator window, choose menu item "App" > "ChromLink™." 
Choose the menu item "Configuration" > "Mass Details" and check the Nominal Name 
and Mass for mercury. If it is missing or altered then ChromLink™ needs to be 
configured (see Appendix H:Error! Reference source not found.B Configuration of ELAN® 
ChromLink™ for details).  

b) Check that the Mode field indicates "Automatic - Process all NetCDF files in specified 
location". If it does not, click the Set button to the right of this field and in the resulting 
"Operating Mode" dialog box, click the "Automatic - process all NexION® NetCDF files in 
specified location" radio button, then click the OK button. Next, check that the Field 
labeled " ELAN® NetCDF file - location/file to be converted" indicates the correct data 
folder. This will be "C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS\ReportOutput\*.nc". If it is not, click “Browse” to the right of it and 
navigate to that folder. Double-click on that folder then click "OK" to close the front 
most dialog box. Last, click “Browse” to the right of the field labeled "ELAN® 
ChromLink™ file location..." In the dialog box "Select TotalChrom Data Location", 
navigate to the folder containing the run data and double-click on it. Click “OK” to close 
that dialog box. In the ELAN® ChromLink™ window, click the button "Start Processing 
ELAN® Data Files" to start processing of the run data. A new dialog box will open and 
provide current information on the status of the data conversion.  

c) When data conversion by ChromLink™ is completed within a minute or two, a message 
in the step field will indicate "Successfully Finished". Click “Close.” At this point, you may 
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close the ELAN® ChromLink™ application by choosing "File" > "Exit" or clicking on the 
window "x" box. In the resulting "OK to quit?" confirmation dialog box, click "OK."  

(4) In the TotalChrom™ Navigator window, choose the menu item "Build" > "Method." Click
the "Load method stored on disk" radio button and click "OK." In the TotalChrom™ File-
Open" dialog box, find C:\GC\Methods folder and open the "HgSpecGC1.mth" file. The
template method file will now be loaded.

(5) If instead of loading the method file, an error message appears stating that the file is
unavailable because it is in use and asks if you would like to open it in Read-Only mode,
click the "No" button. Cancel the Open-File dialog box. Exit the Graphic Method Editor. In
the Navigator window, choose menu item "Admin" > "CAM Administrator." A window will
appear with two panes. In the left pane, click on the "+" sign in front of "TotalChrom
Servers" to expand it. Click on the computer icon on the next line that just appeared to
highlight it. In the right pane, under the heading "Resource/Instrument", select the first
item. If there is more than one item, select every item by shift-clicking on each item. Every
item will now be highlighted. Choose "Edit" > "Remove Locks" (or press the Delete key on
the keyboard). Next, click on the "+" sign in front of "Users" to expand it. Click to highlight
your TotalChrom™ user name that appeared. In the right pane, under the heading
"Resource/Instrument", select every item and Choose "Edit" > "Remove Locks." This action
serves to unlock files and make them available for editing. If in the future, TotalChrom™
gives an error message that files cannot be edited because they are locked, use CAM
Administrator to unlock them. Choose "File" > "Exit" to quit CAM Administrator. Start again
at the beginning of this step to open the Method Editor.

(6) Choose "File" > "Save As." At the next window, you will be prompted to enter information
about the method. You may enter pertinent information but this is optional. Click the "OK"
button and a TotalChrom™ “File-Save-As" dialog box opens. Navigate the directory tree to
get to the folder that contains theNexION® data files for this run (typically in the folder
C:\GC\Data\). Double-click on this folder. In the "File name:" field, enter the same name as
it exactly appears for the folder that will contain it (i.e., Hg<yymmdd> convention where
yy=2-digit year, mm=2-digit month, dd=2-digit date). Click the "Save" button then close the
"Method Editor" window.

(7) In the TotalChrom™ Navigator window, choose the menu item "Build" > "Graphic Edit." A
TotalChrom™ “File-Open" dialog box appears, but click on cancel to close it. On the Graphic
Method Editor's menu bar, choose "File" > "Open" and navigate the file-open dialog box to
the folder containing the method file created in the preceding step. Click on that file and
click the "Open" button. Return to the Graphic Method Editor's menu bar and choose "File"
> "New Data File." Navigate to C:\GC\Data\ and double-click on the folder containing the
run data. Find and click on a data file (indicated by the ".raw" extension) that corresponds
to the "-LB19009". When this file appears in the File Name field, click the "Open" button. If
a message box appears with the warning "Unable to open this file: default.mth", click "OK"
to clear the message (you do not have to go to CAM Administration to unlock it). Do the
same if another message warning box appears (i.e., click "OK" again to clear it). You will be
in the "Graphic Method Editor - <path to method file>" window and see a chromatogram.

(8) Under the menu item "Calibration" > "Show Windows" there will be a check mark beside
"Show Windows." Retention window bars (looks like "H" style error bars) will be present
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when it is checked. Each retention time window bar will be located above the 
chromatographic baseline and contain an identified peak within its bounds. If there are any 
bars at the bottom of the chromatogram located below the baseline, choose menu item 
"Calibration" > "Edit Components." Click on the first mercury species peak that falls outside 
its retention time window to select it. In the group of data fields located on the right side of 
the window, click on the "Name" dropdown arrow (located on the right side of the data 
entry field) and choose the appropriate species by name. It is usually not necessary to alter 
the retention time window's "Absolute" and "Relative" window parameters, but you may 
do so if experience dictates that a change will be beneficial. Click the "Next" or "Prev" 
button. Repeat these steps for each mercury species peak that was not properly identified 
because it was outside its retention time window. When the editing of peak retention time 
windows is complete, click on the menu bar item "Return". Next, choose "File" > "Save" 
followed by "File > Exit".  

(9) Launch Microsoft® Excel and choose menu item “Hg SPECIATION” > “Create TC Sequence 
File” (the Excel macro “Extract TC Data.xls” must be installed in Excel’s Startup folder). In 
the open file dialog box, navigate to the current working GC data folder. Click on a RAW file 
then click the “Open” button. Wait about 30 seconds until a “Done” message box appears. 
You may leave Excel open. Skip the following step unless, for some reason, the Excel menu 
item “Hg SPECIATION” > “Create TC Sequence File” cannot be run: 

a) Navigate to the folder containing the run data and click on the sequence file (ends with 
".seq") corresponding to the run (named "Hgyymmdd.seq" where yy=2-digit year, 
mm=2-digit month, dd=2-digit date ). Click the "Open" button. A spreadsheet style 
sequence table will present itself in a window called "Sequence Information - Channel 
A". There will be a minimized window for channel B data, ignore this window. Look for 
the "Method" column and click on the first cell in row 1 in this column. Right click the 
mouse and a contextual menu will appear; choose "Browse". In the resulting File-Select 
dialog box, navigate and choose the method file (ending in ".mth") created earlier. Click 
on the Select button. The path and name of the new method file will replace the default 
information in this cell. Right click this cell again and choose Fill Down. The new file 
name information will fill down to every cell in the "Method" column.  

b) Look for the "Rpt Fmt File" column and follow the same process that was followed with 
the "Method" column. Instead of choosing the method file (ending in ".mth"), choose 
the report file (ending in ".rpt”). If the report file is not listed, click on the "default.rpt" 
file. In the bar that contains the file's path, change the "default" to "Hgyymmdd." Right 
click this cell again and choose Fill Down. The new file name information will fill down to 
every cell in the "Rpt Fmt File" column.  

(10) In the TotalChrom™ Navigator window, choose the menu item "Reprocess" > "Batch." A 
new window appears titled "Batch Reprocessing". Choose menu item "File" > "Sequence" 
and another window appears titled "From Sequence". Locate the top field labeled 
"Sequence file" and look for a button with an open folder icon immediately to the right of 
the field. Click this button and navigate, if necessary, to the folder containing the run's 
sequence files. Click on the sequence file and click the "Open button." Upon return to the 
previous window, set Start Analysis to "Peak Detection" and End Analysis to "Quantitation". 
Set Batch Printer to "pdfFactory Pro". Change Batch Execution to "ndlb-168462" or 
anything other than "Interactive". Check "overwrite existing result files" and select "Update 
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existing raw file header with new sequence". All other parameters will remain unchanged. 
The parameters are shown in TABLE 8-8.  

(11) Click the "OK" button. Reprocessing of the chromatographic raw data will commence. The
bottom panel in the window will update with each file's name as it is processed. When
processing is done, this panel will be clear of files. Close this window.

(12) In the TotalChrom™ Navigator window, choose the menu item "Reprocess" > "Results." A
new window will open called "Reprocess Results". If you get an error message telling you
that you can only open this in read-only mode, then unlock the files (follow the procedure
described in step 4 of this section). Select from the menu "File" > "Open." In the open file
dialog box, click on the "Files of type:" dropdown menu and select "IDX files (*.idx)".
Navigate to the folder containing this run's data and click on the newest file (in the format
of "Hg<yymmdd>-<today's date>-<time of reprocessing>"). Click "Open." A chromatogram
for the first sample in the sequence will appear in the “Reprocess Results” window.
Carefully inspect the chromatogram one peak at a time for correct peak identification and
accurate baseline. If you are satisfied that there are no integration problems, proceed to
the next sample's chromatogram by selecting "File" > "Next File" from the menu bar or
pressing "F3." Examine all chromatograms in this manner and make corrections in peak
identity and integration as necessary. Make notes concerning issues encountered with
individual chromatograms and changes that were made. If a chromatogram is changed or
edited in any way, be sure to select "File" > "Save" to save your changes. See the chapter
titled "Developing Processing Parameters in the Method" in the PerkinElmer TotalChrom™
Workstation Users Guide for a detailed explanation on how to use integration events to
optimize the integration of a chromatogram. After review of each chromatogram, select
"File" > "Exit" from the Reprocess Results menu bar.
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Figure 2 Post-Run Data Processing Workflow Diagram 
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Table 11 TotalChrom™   Navigator - Reprocess Batch 

Parameter Name  Parameter Setting 

Starting Row : 1 

Ending Row : <number of rows in sequence file> 

Channel A : Checked 

Channel B : Not Checked 

Start Analysis : Peak Detection 

End Analysis : Quantitation 

Batch Execution : ”Interactive” or “nexionr-pc” or equivalent 

Batch Printer : pdfFactory Pro 

Batch Plotter : None 

Enable Optional Report(s) in Method 

Use Method is Result File 

: Not Checked 

 

Grayed Out 

Overwrite Existing Result Files : Checked 

Raw File Treatment : Update existing raw file header with new 
sequence 

 

(13) Repeat step 9 except set both Start and End Analysis to "Report Generation". Set Batch 
Printer to "pdfFactory Pro". A new window will open. When reprocessing has completed, 
click the "Save" button on the pdFactory Pro window. In the Save As dialog box that 
appears, navigate to the run's data folder and create a new pdf file named "Hg<yymmdd> 
report". Be sure to include a space between "report" and the first word of the new file. 
Click "Save.” This pdf file is to be kept and backed up, for archival purposes, in the same 
folder with all the other chromatographic data files for this run. Click "Close" to close 
pdFactory Pro window.  

(14) Open Microsoft Excel and choose "Hg SPECIATION" > "Import TC Files" from the menu. In 
the open file dialog box, navigate to the folder containing the run's data files. A box titled 
"Choose a Sequence File" will appear. Navigate to the folder that contains the sequence file 
that you are working with. Double click on the sequence file. Immediately a macro will run 
that will extract the data and put it into a format that is easily exported into the Laboratory 
Information Management System. Just before the macro finishes, a "Save As" dialog box 
will open giving you the opportunity to save the file as an Excel workbook. Give the file a 
name as follows: "Hg<yymmdd> results". The multi-tabbed Excel workbook can be parsed 
to obtain a worksheet that is suitable for data exportation into DLS STARLIMS.  

(15) Calculated “spike” concentrations for enriched InHg, MeHg, and EtHg in triple spike 
standards solution will be entered in the column “ppb Spike” in Microsoft Excel. On the 
Microsoft Excel toolbar, choose "Hg SPECIATION" > "Deconvolute All Samples" from the 
menu. Sample concentration values will be calculated and appear in the column “ppb 
Result”.  

Mercury:  Inorganic, Ethyl, and Methyl - Blood 
NHANES August 2021 - August 2023

38 of 91



(16) The data processing portion on the instrument controller computer is now complete. At
this point you may close Microsoft Excel® and TotalChrom™ Navigator.

(17) Throughout the sample analysis it is important to ensure that three mercury species peaks
(InHg, MeHg, and EtHg) are well resolved. Thus, the following criterion is followed to
accept/reject the sample analysis. The Microsoft Excel document containing concentration
results displays retention times for each mercury species in the column labeled “RT”.
Mercury species elute from a chromatographic column in the following order MeHg, EtHg,
InHg with relative retention times tr1, tr2, tr3, respectfully. For the purpose of establishing
relevant criterion, relative retention time for InHg (tr3) is set to 1. The ratio (tr2/tr1) =0.91
± 0.13 and (tr3/tr1)=0.77 ± 0.12 (± represents three times standard deviation). If the
relative retention time ratios fall outside the allowable error, the sample analysis must be
repeated.

(18) Transfer data to the laboratory LIMS; see Appendix C: General instructions for uploading
data to Starlims for instructions.

(19) After an analytical run has been uploaded to the LIMS system, the analyst should note
which, if any, samples are noted as anything other than “Pass” or “<LOD” in the “Status
Message” column.

a) Any sample that has an analytical result above 10 µg/L (i.e., 2UB) but below 30 µg/L for
any analyte must be redigested, repeated, and confirmed for that analyte. Report the
first analytically valid result, as long as the confirmation is within 10%. Continue repeat
preparation and analysis until a concentration can be confirmed.

b) Any sample that has an analytical result that saturates the instrument detector (typically
above 30 µg/L) for any analyte must be redigested, repeated, and confirmed for that
analyte, see Section 9.

c) If the run QC fails, the following steps must be taken, if possible:

1. Check the chromatograms for each blank, QC, and sample for proper peak
integration and identification. Change integration parameters or manually
reintegrate peaks, if necessary, and reprocess the run in TotalChrom™.

2. Setup a new run for the reanalysis of the patient samples affected by the previous
failed run. Be sure to use freshly prepared QC material.

3. If these steps do not result in correction of the out-of-control values for QC
materials, consult the supervisor for other appropriate corrective actions. No
analytical results will be reported for runs that are not in statistical control.

F. Special Method Notes

(1) Instrument Shut Down

a) The autosampler will stop after all samples have been analyzed.

b) Shut off ICP-DRC-MS plasma.
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c) At the controller computer, visit the NexION® Instrument Control Session application
and open the "Dataset" window. Confirm that all samples ran successfully and that the
corresponding data for each sample is listed in this window.

(2) Waste Disposal

a) Chemical waste generated during sample preparation must be disposed of through the
CDC Online Waste Ticketing System (OWTS)

b) Remove the QC and sample vials from the GC tray. Discard them according to CDC
biohazard waste disposal guidelines.

G. Calculations

(1) We programmed the CombiPAL® autosampler using Chronos™ software (LEAP
Technologies Inc., Carrboro, NC, USA) which controls the timings for SPME fiber exposure
to the sample (adsorption) and fiber injection into the GC (desorption). Our laboratory
used ELANSyngistix® software (PerkinElmer Life Sciences, Shelton, CT, USA) to process ICP-
MS intensity signals of three mercury species (inorganic, methyl, and ethyl) measured at
m/z 198, 199, 200, 201 and 202.

(2) TotalChrom™ version 6.3 (PerkinElmer Life Sciences, Shelton, CT, USA) handled
chromatography data manipulations. The ChromLink™ feature of TotalChrom™ interfaces
ICP-MS and GC data. Using an in-house written macro, we imported the integrated peak
areas for InHg, MeHg and EtHg from TotalChromTM into a Microsoft Excel spreadsheet
where the 198Hg/202Hg, 199Hg/202Hg, 200Hg/202Hg, and 201Hg/202Hg ratios were calculated and
exported into a second spreadsheet containing multiple spiking species-specific isotope
dilution mathematical equations developed by Ouerdene and colleagues [12-14]. The Excel
macro is stored in the DLS Informatics Systems and Tools Tracker in STARLIMS (Record
#19).

(3) Several published methods exist for correcting isotopic ratio error attributed to the mass
bias effect [10, 15-20]. We tried a variety of mass bias correction techniques during the
development of our method [16, 18, 21, 22], but none improved our accuracy or precision.
Conversely, we observed an among-run precision degradation as a result of using mass bias
correction. Therefore, we monitor mass bias error by checking measurements of isotopic
ratios in unspiked blood samples against the expected ratios for natural abundance (IUPAC
abundances) mercury, the difference in abundance ratios should be less than 10% to
ensure mass bias error contribution is not significant.

H. CDC Modifications

None
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9. Reportable Range of Results (AMR – Analytical Measurement Range)

The reportable range of results for Hg species are listed in Table 5.  The lower reportable limit is the
limit of detection (LOD). The upper reportable limit is not limited by a calibration standard because
there are no calibration standards used with this method. Instead, the upper reportable limit is
based on a concentration that causes the instrument signal to saturate the detector. This typically
occurs around 30 µg/L. We check mercury species chromatographic peak shape to determine if the
detector is saturated.  When signal saturation occurs, the tops of chromatographic peaks look flat.
Samples that are initially measured with a Hg species concentration that saturates the detector can
be diluted. Extra sample dilutions (with base blood) are allowed to bring a Hg species concentration
to a level below 30 µg/L. Use the lowest dilution factor possible. Discuss reporting results from an
extra sample dilution with the Technical Supervisor.

Table 12 Reportable range of Hg species 

Hg species LOD Lower reportable limit* Upper reportable limit** 

MeHg, EtHg, IHg See Appendix A: Method LOD 30 µg/L 
*Lower reportable limit is the method LOD.
**The upper reportable limit is the concentration (before extra dilution) that typically saturates the instrument detector.

10. Quality Control (QC) Procedures

A. Blind Quality Controls

No blind QC samples are used with this method.

B. Bench Quality Controls

Bench QC samples are prepared from a minimum of two pools that represent low and high
levels of Hg species. This assay typically uses two blood pools that represent low and high levels.
Samples from these pools are prepared in the same manner as patient samples and analyzed in
duplicate as part of each run (placed at the beginning and end of each run).

The results from these pools are checked after each run using a multi-rule quality control system
[23] based on their characterization data, namely: the pool mean; the pooled within-run
standard deviation associated with individual QC results measured in the same run (Sw); the
standard deviation associated with individual QC results (Si); and the standard deviation
associated with run mean QC results (Sm). QC rules have been designed to accommodate the
use of 1–3 different QC pools during a run, the use of 1–2 measurements of each pool per run,
and as many instruments as needed. These QC rules are described in the DLS Policies and
Procedures Manual and a relevant selection applicable to this assay is shown below. The system
is declared “in control” if all individual QC results are within 2S limits; the run is accepted. If not,
then the rules shown below are applied and the run is rejected if any condition is met; the run is
declared “out of control”:

(1) If 1 of the 3 QC run means is outside a 2Sm limit - reject run if:

a) Extreme Outlier – Run mean is beyond the characterization mean +/- 4Sm

b) 3S Rule - Run mean is outside a 3Sm limit
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c) 2S Rule - 2 or more of the 3-run means are outside the same 2Sm limit

d) 10 X-bar Rule – Current and previous 9 run means are on same side of the
characterization mean

(2) If one of the QC individual results is outside a 2Si limit - reject run if:

a) Extreme Outlier – One individual result is beyond the characterization mean +/- 4Si

b) R 4S Rule - 2 or more of the within-run ranges in the same run exceed 4Sw (i.e., 95%
range limit). Note: Since runs have multiple results per pool for 3 pools, the R 4S rule is
applied within runs only. Within both the low-and the high-QC results are within the 2s
limits, the run will be accepted.

A QC program written in SAS is available from the DLS Quality Assurance Officer and should be 
used to apply these rules to QC data and generate Shewhart QC charts. No results for a given 
analyte are to be reported from an analytical run that has been declared “out of control” for 
that analyte as assessed by internal (bench) QC. 

The initial limits are established by analyzing pool material in at least 20 analytical runs. The SAS 
QC program is used to monitor the QC performance over time for potential shifts, trending, or 
changes in assay precision. For assays performed routinely, quarterly statistics (mean, SD, CV) 
are calculated for each pool and compared to the characterization target values. For assays 
performed infrequently, statistics are calculated at least annually. As more QC data become 
available (covering multiple lots of reagents, multiple analysts, etc.), the initial QC limits can be 
reevaluated and updated. QC limits can also be reevaluated and updated as a result of a non-
conforming event when the assay shows a higher than expected out of control rate and the root 
cause investigation does not reveal a correctable course of action to bring the assay back into 
control. This needs to be documented by a CAPA in STARLIMS. 

While a study is in progress, QC results are stored in the STARLIMS database. For runs that are 
not imported into the database (e.g., R&D, troubleshooting, research-type runs), QC results are 
stored electronically on the instrument control computer. At the conclusion of studies, complete 
QC records are prepared and submitted as a study QC report in STARLIMS for review by the 
deputy branch chief or laboratory chief, branch chief, and a DLS statistician. 

C. Sample QC Criteria

Sample QC is a set of criteria used to evaluate the quality of individual test results within a run,
and to evaluate the quality of the calibrators associated with the run. In addition to the sample
QC criteria set forth in the DLS Policies and Procedures Manual that pertain to the reportable
range of concentration results and calibration curves, sample QC criteria are also established for
method-specific concentration and non-concentration data associated with an individual result.

The method-specific concentration and non-concentration parameters identified for sample QC
evaluation, along with their associated thresholds and flagging protocols (‘Pass’, ‘Check’, ‘Warn’,
‘Fail’, ‘Incmp’) are maintained and updated in the LIMS database, and sample QC assessment is
performed and documented as part of run review process. No numerical results should be
reported for a sample with sample QC result flagged as ‘fail’. A sample QC result flagged ‘Warn’
or ‘Check’ should be reviewed both by the analyst and supervisor to determine if the quality of
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the result is suitable for reporting. Results that are flagged during sample QC evaluation may 
also be assigned one of a series of standard comment codes available in the LIMS database to 
identify the nature of the sample QC flag. 

At a minimum, the following parameters are subject to sample QC evaluation in this method. 
Additional parameters may also be included as needed: 

(1) Hg species retention times and relative retention times are defined in the TotalChrom
software (see Error! Reference source not found.). Analysts confirm the correct peaks are
integrated prior to processing data and uploading to LIMS.

(2) Samples may require repeat analysis for confirmation or an extra sample dilution (see
Section 8.E(19)).

(3) No numeric analyte results < LOD should be reported.

(4) No numeric analyte results should be reported for samples that were not analyzed, e.g.,
missing vial, sample disqualification, QNS.

11. Remedial Action if Calibration or QC Systems Fail to Meet Acceptable Criteria

If the calibration or QC systems fail, all operations are suspended until the source or cause of failure
is identified and corrected. Analytical results are not reported for runs not in statistical control.
Before beginning another analytical run, several QC materials (in the case of QC failure) or
calibration verification samples (in the case of calibration failure) must be analyzed. Once calibration
and/or quality control have been reestablished, analytical runs may be resumed.

12. Limitations of Method; Interfering Substances and Conditions

Care is required to prevent contamination of QC materials, calibrators, and samples. The
chromatograms may show other mercury species due to the nature of the matrix analyzed in this
procedure.

13. Reference Ranges (Normal Values)

The reference range for each mercury species (see Table 13) is based on the most recent data
publicly available from the measure of the species in NHANES. Where data is absent or scant,
references ranges are based on the scientific literature, if available.

Table 13 Reference range for mercury species 

Species Chemical Name Reference Range1, µg/L 

Inorganic Hg 0.350 (90th percentile), 0.480 (95th percentile) 

Methyl Hg 0.380 (50th percentile), 1.02 (75th percentile), 2.30 (90th 
percentile), 3.92 (95th percentile), 0.413 (geometric 
mean)  

Ethyl Hg2 < LOD 
1 Above ranges are taken from NHANES population data for the 2015 to 2016 survey years as provided in the Fourth National 
Report on Human Exposure to Environmental Chemicals, Updated Tables, January 2019 (Volume One).   Sample sizes were 
n=4938 for inorganic mercury and methylmercury. (http://www.cdc.gov/exposurereport/). 
2 There are no established reference ranges for EtHg. 
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14. Critical Call Results (“Panic Values”)

The analyst will report any patient results confirmed to be greater than the second upper boundary
(defined in the laboratory information management system as the "2UB") to the QC reviewer as an
"elevated result". The concentration assigned to the 2UB for a mercury is determined by study
protocol, but the default concentration is currently 10 µg/L. The protocol for supervisors reporting
elevated results to medical personnel is defined according to the study protocol. The American
Conference of Governmental Industrial Hygienists has a biological exposure index (BEI) of 15 μg/L
for inorganic mercury in blood (end of shift at end of work week) [24].

15. Specimen Storage and Handling during Testing

Specimens may reach and maintain ambient temperature (15°C to 30°C) during analysis. Take
stringent precautions to avoid external contamination. After the samples are analyzed, return them
to deep-frozen conditions (-50°C to -90°C, set point typically –70°C) as soon as possible.

16. Alternate Methods for Performing Test of Storing Specimens if Test System Fails

No alternate methods are available for measuring Hg species in blood. If an analytical system fails,
prepared samples can be analyzed within 24 hours (see Appendix A: Stability). Store remaining
sample aliquots according to the storage requirements described in Section 4 of this document, until
the analytical system can be restored to functionality.

17. Test Result Reporting System; Protocol for Reporting Critical Calls (If Applicable)

Test results that are approved for reporting are exported as an electronic file from the LIMS
database. The data may be combined in a reporting packet that could include items e.g., a cover
letter, a table of method specifications and reference range values, a QC memo, and QC. After
approval at the division level, the report will be sent to the designated contact person for the
reporting of the results.

18. Transfer or Referral of Specimens; Procedures for Specimen Accountability and
Tracking

This protocol does not involve referral of specimens for testing the analytes of this method at
another laboratory.

DLS uses a unique barcoded specimen ID number affixed to the sample to identify and track
individual samples, and which links the laboratory information to demographic data recorded by
those who collected the sample. To safeguard confidentiality, only the person outside of DLS
requesting the laboratory analysis will maintain information which links the specimen ID number to
the patient's name. Personal identifiers (e.g., names) are not included on samples. Barcoded sample
IDs are indexed in STARLIMS to both a CDC specimen identifier (CSID) and a CDC unique identifier
(CUID).

Retention of samples is determined by specifications in each study protocol. A copy of each study
protocol is kept in DLS STARLIMS.
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Location, status, and final disposition of specimens are tracked in DLS STARLIMS according to the 
IRAT specimen tracing SOP [document number TBD]. Records are maintained for a minimum of 3 
years. 

19. Method Performance Documentation

Method performance documentation for this method including accuracy, precision, sensitivity,
specificity, and stability is provided in Appendix A of this method documentation. The approval of
this procedure by the Branch Chief and CLIA Director denote that the method performance is fit for
the intended use of the method.

20. Summary Statistics and QC Graphs

Please see following pages
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August 2021-August 2023 Summary Statistics and QC Chart 
LBXIHG (Mercury, inorganic (ug/L)) 

Lot N 
Start 
Date 

End 
Date MEAN 

Standard 
Deviation 

Coefficient of 
Variation 

LBCIHH8_6733 81 18OCT21 11AUG22 2.322 0.070 3.0 

LBCIHH9_6733 138 30SEP22 06OCT23 2.299 0.073 3.2 

LBCIHL8_6732 81 18OCT21 11AUG22 0.953 0.033 3.5 

LBCIHL9_6732 138 30SEP22 06OCT23 0.935 0.029 3.2 
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August 2021-August 2023 Summary Statistics and QC Chart 
LBXBGE (Mercury, ethyl (ug/L)) 

Lot N 
Start 
Date 

End 
Date MEAN 

Standard 
Deviation 

Coefficient of 
Variation 

LBCGEH6_6733 81 18OCT21 11AUG22 1.0020 0.0179 1.8 

LBCGEH7_6733 138 30SEP22 06OCT23 0.9572 0.0391 4.1 

LBCGEL6_6732 81 18OCT21 11AUG22 0.4712 0.0079 1.7 

LBCGEL7_6732 138 30SEP22 06OCT23 0.4556 0.0185 4.1 
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August 2021-August 2023 Summary Statistics and QC Chart 
LBXBGM (Mercury, methyl (ug/L)) 

Lot N 
Start 
Date 

End 
Date MEAN 

Standard 
Deviation 

Coefficient of 
Variation 

LBCMGH6_6733 81 18OCT21 11AUG22 3.351 0.047 1.4 

LBCMGH7_6733 138 30SEP22 06OCT23 3.294 0.073 2.2 

LBCMGL6_6732 81 18OCT21 11AUG22 0.923 0.014 1.6 

LBCMGL7_6732 138 30SEP22 06OCT23 0.913 0.021 2.3 
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Appendix A: Method Performance Documentation 

Figure 3 Accuracy data of the method evaluated using spike recovery for inorganic mercury 

Accuracy using Spike Recovery
Recovery = (final concentration – initial concentration)/added concentration

Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Mean 

recovery (%)

SD 

(%)

Sample 1 0.340 0.110 0.950 0.890

2 0.110 0.110 0.870 0.880 97.2 3.4

3 0.092 0.100 0.910 0.870

Sample + Spike 1 1 5.47 5.41 5.75 5.38

2 5.16 5.17 5.90 5.73

3 5.30 5.29 5.37 6.01

Sample + Spike 2 1 10.1 10.7 10.6 10.0

2 9.55 10.2 11.5 10.3

3 9.56 10.4 10.4 9.07

Sample + Spike 3 1 15.2 12.6 15.5 15.4

2 15.5 13.5 14.7 15.4

3 15.7 13.5 15.4 15.7

10.1

14

103.1

99.2

0.0

5.0

10.0

15.0
94.5

Sample 1

Measured concentration

0.1

5.3

Inorganic Mercury (IHG)

Mercury Speciation in blood

15.0
15 96.2

5.0
5.7 95.9

10.0
10.3 94.2

Sample 2

Measured concentration

0.0
0.9
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Figure 4 Accuracy data of the method evaluated using spike recovery for methylmercury 

 

Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration

Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Mean 

recovery (%)

SD 

(%)

Sample 1 0.120 0.117 0.660 0.616

2 0.082 0.192 0.670 0.725 89.9 2.0

3 0.130 0.220 0.670 0.679

Sample + Spike 1 1 3.75 3.96 4.19 4.33

2 3.76 3.96 4.46 4.34

3 3.87 3.87 3.89 4.28

Sample + Spike 2 1 7.05 7.27 7.86 8.42

2 7.17 7.78 7.62 7.61

3 6.96 7.01 7.56 7.80

Sample + Spike 3 1 10.7 10.4 11.4 11.1

2 10.8 10.6 11.4 11.2

3 10.9 10.6 11.1 11.0

7.2

11

93.7

89.1

0.0

3.97

7.93

11.9
88.4

Sample 1

Measured concentration

0.1

3.9

Methylmercury (BHGM)

Mercury Speciation in blood

11.9
11 88.3

3.97
4.2 90.1

7.93
7.8 90.0

Sample 2

Measured concentration

0.0
0.7
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Figure 5 Accuracy data of the method evaluated using spike recovery for ethyl mercury 

Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration

Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Spike 

concentration
Day 1 Day 2 Mean

Recovery 

(%)

Mean 

recovery (%)

SD 

(%)

Sample 1 0.00 0.00 0.51 0.47

2 0.020 0.01 0.50 0.48 91.2 4.4

3 0.012 0.00 0.47 0.48

Sample + Spike 1 1 4.08 4.34 4.57 4.67

2 4.00 4.14 4.95 4.64

3 4.20 4.26 4.73 4.5

Sample + Spike 2 1 7.68 8.06 8.63 8.19

2 7.43 7.92 8.26 8.50

3 7.95 8.00 8.49 8.51

Sample + Spike 3 1 10.6 11.5 12.0 11.7

2 11.6 11.6 12.7 11.9

3 10.2 11.5 11.7 11.2

Ethyl Mercury (BHGE)

Mercury Speciation in blood

13.03
12 87.4

4.34
4.7 96.6

8.69
8.4 91.4

Sample 2

Measured concentration

0.0
0.5

Sample 1

Measured concentration

0.0

4.2

7.8

11

95.9

90.1

0.0

4.34

8.69

13.03
85.7
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Figure 6 Precision of the method evaluated using total relative standard deviation for inorganic mercury 

Precision
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 0.824 0.770 0.80 0.000729 0.000729 1.270418

2 0.759 0.767 0.76 1.64025E-05 1.64025E-05 1.164185405

3 0.759 0.769 0.76 2.65225E-05 2.65225E-05 1.167544805

4 0.829 0.786 0.81 0.000455822 0.000455822 1.303628045

5 0.850 0.884 0.87 0.000283923 0.000283923 1.503551405

6 0.755 0.752 0.75 2.56E-06 2.56E-06 1.13431922

7 0.864 0.982 0.92 0.003522423 0.003522423 1.704042605

8 0.796 0.808 0.80 3.364E-05 3.364E-05 1.28544578

9 0.808 0.793 0.80 5.70025E-05 5.70025E-05 1.282721445

10 0.945 1.00 0.97 0.00072361 0.00072361 1.89073458

Grand sum 16.4988 Grand mean 0.82494

Sum squares Mean Sq Error Std Dev

Rel Std Dev 

(%)
Within Run 0.01170181 0.001170181 0.034207908 4.15

Between Run 0.096071218 0.01067458 0.068936198 8.36

Total 0.107773028 0.076957004 9.33

Quality material 2

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 2.06 1.97 2.01 0.00196249 0.00196249 8.08904642

2 2.00 1.97 1.98 0.000297563 0.000297563 7.862595125

3 1.96 2.11 2.04 0.00555025 0.00555025 8.29629378

4 2.06 1.95 2.00 0.002704 0.002704 8.03123042

5 2.17 2.31 2.24 0.004907003 0.004907003 10.06164941

6 2.15 1.99 2.07 0.006715802 0.006715802 8.580153125

7 2.40 2.45 2.42 0.00061504 0.00061504 11.75252162

8 1.95 2.03 1.99 0.001432623 0.001432623 7.925374845

9 2.24 2.09 2.16 0.005076563 0.005076563 9.374017005
10 2.36 2.54 2.45 0.007788062 0.007788062 11.98002301

Grand sum 42.7516 Grand mean 2.13758

Sum squares Mean Sq Error Std Dev Rel Std Dev 

Within Run 0.07409879 0.007409879 0.086080654 4.03

Between Run 0.567939622 0.063104402 0.166874988 7.81

Total 0.642038412 0.187768849 8.78

Inorganic Mercury (IHG)

Mercury Speciation in blood
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Figure 7 Precision of the method evaluated using total relative standard deviation for methylmercury 

Precision 
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 0.656 0.667 0.66 2.97025E-05 2.97025E-05 0.875826125

2 0.688 0.685 0.69 3.4225E-06 3.4225E-06 0.942701805

3 0.689 0.705 0.70 6.4E-05 6.4E-05 0.9702245

4 0.690 0.663 0.68 0.00018769 0.00018769 0.91476338

5 0.701 0.664 0.68 0.000344103 0.000344102 0.932568245

6 0.706 0.687 0.70 9.025E-05 9.025E-05 0.97106048

7 0.698 0.643 0.67 0.000764522 0.000764523 0.898202045

8 0.658 0.686 0.67 0.000196 0.000196 0.90370568

9 0.654 0.683 0.67 0.000205922 0.000205923 0.894185645

10 0.652 0.643 0.65 2.07025E-05 2.07025E-05 0.838901045

Grand sum 13.5188 Grand mean 0.67594

Sum squares Mean Sq Error Std Dev

Rel Std Dev 

(%)
Within Run 0.00381263 0.000381263 0.019525957 2.89

Between Run 0.004241278 0.000471253 0.006707835 0.99

Total 0.008053908 0.020646018 3.05

Quality material 2

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 3.70 3.61 3.66 0.001993622 0.001993623 26.75680705

2 3.44 3.55 3.49 0.00303601 0.00303601 24.3951125

3 3.63 3.43 3.53 0.00978121 0.00978121 24.91332872

4 3.54 3.48 3.51 0.001053002 0.001053003 24.65915765

5 3.40 3.50 3.45 0.002495003 0.002495002 23.86230445

6 3.56 3.58 3.57 0.00012321 0.00012321 25.44555122

7 3.57 3.46 3.52 0.002986623 0.002986623 24.75475885

8 3.62 3.47 3.54 0.00514089 0.00514089 25.11136712

9 3.61 3.70 3.65 0.00232324 0.00232324 26.69758592
10 3.22 3.73 3.48 0.06579225 0.06579225 24.15959072

Grand sum 70.8054 Grand mean 3.54027

Sum squares Mean Sq Error Std Dev Rel Std Dev 

Within Run 0.18945012 0.018945012 0.137640881 3.89

Between Run 0.085330722 0.009481191 0 0.00

Total 0.274780842 0.137640881 3.89

Methylmercury (BHGM)
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Figure 8 Precision of the method evaluated using total relative standard deviation for ethyl mercury 

Precision
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 0.44 0.46 0.45 5.476E-05 5.476E-05 0.40446018

2 0.44 0.46 0.45 8.19025E-05 8.19025E-05 0.401497605

3 0.45 0.46 0.45 1.6E-05 0.000016 0.41023682

4 0.43 0.45 0.44 7.921E-05 7.921E-05 0.3863205

5 0.52 0.48 0.50 0.000438903 0.000438903 0.505716245

6 0.43 0.46 0.45 0.00014161 0.00014161 0.39711872

7 0.49 0.47 0.48 0.00016384 0.00016384 0.4617605

8 0.49 0.44 0.46 0.000683823 0.000683822 0.428645405

9 0.52 0.47 0.50 0.00049729 0.00049729 0.49282592

10 0.46 0.44 0.45 0.000109202 0.000109203 0.401856125

Grand sum 9.2534 Grand mean 0.46267

Sum squares Mean Sq Error Std Dev

Rel Std Dev 

(%)
Within Run 0.00453308 0.000453308 0.021291031 4.60

Between Run 0.009167442 0.001018605 0.016812148 3.63

Total 0.013700522 0.027128515 5.86

Quality material 2

Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2

1 0.95 1.0 0.99 0.001751423 0.001751423 1.979055125

2 0.99 1.0 1.01 0.00028224 0.00028224 2.02930658

3 1.0 0.94 0.99 0.00239121 0.00239121 1.9463645

4 1.0 1.0 1.03 3.136E-05 3.136E-05 2.10699392

5 1.0 1.1 1.05 0.000531303 0.000531302 2.189278125

6 1.1 1.1 1.06 1.21E-06 1.21E-06 2.24423298

7 1.0 1.0 1.01 5.0625E-06 5.0625E-06 2.034749645

8 1.0 0.96 0.98 0.00046225 0.00046225 1.92001608

9 1.1 1.0 1.06 0.00015625 0.00015625 2.23534368
10 0.98 1.1 1.04 0.00285156 0.00285156 2.14700642

Grand sum 20.4045 Grand mean 1.020225

Sum squares Mean Sq Error Std Dev Rel Std Dev 

Within Run 0.016927735 0.001692774 0.041143329 4.03

Between Run 0.015166042 0.001685116 0 0.00

Total 0.032093777 0.041143329 4.03

Ethyl Mercury (BHGE)
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Figure 9 Assessing stability of inorganic mercury in whole blood samples. 

Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions

Describe condition: samples frozen three times at -80°C and then thawed (3 freeze-thaw cycles)

Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)

Describe condition: original samples (not yet digested or prepared for instrument analysis) stored at room temperature for 1 day before digestion

Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler

Describe condition: processed samples (already digested) stored at room temperature for 1 day before derivatization and instrument analysis

Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis

Describe condition: samples stored at -80°C  for 5 y ears

All stability sample results should be within ±15% of nominal concentration

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 0.790 0.791 0.790 0.761 0.790 0.803 0.750 0.803

Replicate 2 0.791 0.781 0.791 0.800 0.791 0.788 0.775 0.788

Replicate 3 0.814 0.825 0.814 0.802 0.814 0.827 0.817 0.827

Mean 0.798045333 0.799107333 0.798045333 0.8 0.798045333 0.805898667 0.7808 0.8

% difference from 

initial measurement
-- 0.1 -- -1.3 -- 1.0 -- 3.2

Quality material 2

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 2.06 1.92 2.06 1.96 2.06 1.92 1.78 1.92

Replicate 2 1.98 1.92 1.98 1.95 1.98 2.03 2.26 2.03

Replicate 3 2.03 2.06 2.03 2.05 2.03 1.98 2.43 1.98

Mean 2.020284667 2.0 2.020284667 2.0 2.020284667 1.973469667 2.157141441 2.0

% difference from 

initial measurement
-- -2.6 -- -1.7 -- -2.3 -- -8.5

Inorganic Mercury (IHG)
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Figure 10 Assessing stability of methylmercury in whole blood samples. 

Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions

Describe condition: samples frozen three times at -80°C and then thawed (3 freeze-thaw cycles)

Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)

Describe condition: original samples (not yet digested or prepared for instrument analysis) stored at room temperature for 1 day before digestion

Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler

Describe condition: processed samples (already digested) stored at room temperature for 1 day before derivatization and instrument analysis

Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis

Describe condition: samples stored at -80°C  for 5 y ears

All stability sample results should be within ±15% of nominal concentration

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 0.697 0.689 0.697 0.679 0.697 0.688 0.755 0.688

Replicate 2 0.667 0.701 0.667 0.678 0.667 0.697 0.741 0.697

Replicate 3 0.678 0.670 0.678 0.675 0.678 0.705 0.737 0.705

Mean 0.680514333 0.686867667 0.680514333 0.7 0.680514333 0.696444667 0.744533333 0.7

% difference from 

initial measurement
-- 0.9 -- -0.5 -- 2.3 -- -6.5

Quality material 2

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 3.62 3.60 3.62 3.59 3.62 3.65 3.54 3.65

Replicate 2 3.65 3.50 3.65 3.59 3.65 3.62 3.70 3.62

Replicate 3 3.63 3.70 3.63 3.66 3.63 3.57 3.90 3.57

Mean 3.633373667 3.6 3.633373667 3.6 3.633373667 3.610190667 3.712652379 3.6

% difference from 

initial measurement
-- -0.9 -- -0.5 -- -0.6 -- -2.8

Methylmercury (BHGM)
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Figure 11 Assessing stability of ethyl mercury in whole blood samples 

Stability

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions

Describe condition: samples frozen three times at -80°C and then thawed (3 freeze-thaw cycles)

Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)

Describe condition: original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day before digestion

Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler

Describe condition: processed samples (already digested) stored at room temperature for 1 day before derivatization and instrument analysis

Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis

Describe condition: samples stored at -80°C  for 5 years

All stability sample results should be within ±15% of nominal concentration

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analyte:

Quality material 1

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 0.458 0.464 0.458 0.454 0.458 0.486 0.608 0.486

Replicate 2 0.460 0.500 0.460 0.461 0.460 0.484 0.515 0.484

Replicate 3 0.459 0.473 0.459 0.490 0.459 0.471 0.559 0.471

Mean 0.458870667 0.479011333 0.458870667 0.5 0.458870667 0.480262 0.560533333 0.5

% difference from 

initial measurement
-- 4.4 -- 2.1 -- 4.7 -- -14.3

Quality material 2

Initial 

measurement

Three freeze-

thaw cycles

Initial 

measurement

Bench-top 

stability

Initial 

measurement

Processed 

sample stability

Initial 

measurement

Long-term 

stability

Replicate 1 1.05 1.10 1.05 1.08 1.05 1.05 1.33 1.05

Replicate 2 1.06 1.09 1.06 1.10 1.06 1.08 1.00 1.08

Replicate 3 1.03 1.11 1.03 1.07 1.03 1.07 1.30 1.07

Mean 1.045439 1.1 1.045439 1.1 1.045439 1.066627333 1.211155043 1.1

% difference from 

initial measurement
-- 5.1 -- 3.5 -- 2.0 -- -11.9

Ethyl Mercury (BHGE)
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Figure 12 LOD, specificity and fit for this method 

LOD, specificity and fit for intended use 

Method name:

Method #: 3020

Matrix: Blood

Units: µg/L

Analytes

Limit of Detection

(LOD)

Interferences 

successfully checked in 

at least 50 human 

samples

Accuracy, precision, LOD, 

specificity and stability meet 

performance specifications 

for intended use

Inorganic Mercury 0.21 yes yes

Methylmercury 0.26 yes yes

Ethyl Mercury 0.064 yes yes
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Appendix B: Ruggedness Testing 

A. Critical Parameter Test #1

Evaluate the significance of the GC injector temperature

Test Details (to be repeated for each temperature):

(1) Set up the analysis in accordance with the prescribed method.

(2) Set the injector temperature to 200°C (reduced temperature).

(3) Digest blood QC according to the prescribed method.

(4) Analyze all digested samples together in one run.

(5) Repeat the analysis using an injector temperature of 220°C (the method prescribed
temperature).

(6) Repeat the analysis using an injector temperature of 230°C (increased temperature).

Table 14 Critical Parameter Test 1 Results: Temperature of the GC injector 

Critical Parameter Test 1 Results. Temperature of the GC injector. One quality control pool was tested. 
Results below are the averages of observed results at each condition along with the 95th percent confidence 
intervals (in parentheses).  

QC 
Pool ID 

GC injector 
Temperature (°C ) 

InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

200°C (Reduced) 
1.27 

(1.17, 1.38) 
1.04 

(0.99, 1.09) 
1.22 

 (1.14, 1.30) 

220°C (Per Method) 
1.28 

(1.00, 1.55) 
1.08 

(1.00, 1.16) 
1.32 

(1.27, 1.36) 

230°C (Increased) 
1.39 

(1.27, 1.51) 
1.09 

(1.02, 1.17) 
1.20 

(1.06, 1.35) 

Expected Range ( ± 2 SD)* (0.71-1.76) (0.71-1.37) (0.84-1.64) 

*Expected range is a determined range calculated from the mean ± 2 SD of a 22-run characterization.

Conclusion: All of the analytes fell within 2SD of the mean at all temperatures; however, it was 
confirmed during method development that the GC injector temperature of 220°C was the optimal 
choice. 
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A. Critical Parameter Test #2  

Evaluate the significance of the CombiPAL®-agitator equilibration/extraction temperature 

Test Details (to be repeated for each temperature):  

(1) Set up the analysis in accordance with the prescribed method. 

(2) Set the agitator equilibration/extraction temperature to 40°C (elevated temperature). 

(3) Digest blood QC according to the prescribed method. 

(4) Analyze all digested samples together in one run. 

(5) Repeat the analysis using an equilibration/extraction temperature at room temperatures 
(RT) ~ 25°C (the method prescribed temperature). 

(6) Repeat the analysis using an equilibration/extraction temperature of 50°C (increased 
temperature). 

Table 15 Critical Parameter Test 2 Results. Temperature of the CombiPAL 

Critical Parameter Test 2 Results. Temperature of the CombiPAL® – agitator equilibration/extraction. One 
quality control pool was tested. Results below are the averages of observed results at each condition along 
with the 95th percent confidence intervals (in parentheses).  

QC  
Pool ID 

Equilibration/Extraction 
Temperature (°C) 

InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

~ 25°C (RT) (Per Method) 
1.42 

(1.20, 1.65) 
1.05  

(1.03, 1.07) 
1.17 

 (1.07, 1.27) 

  40°C  (Increased) 
1.33 

(1.27, 1.39) 
1.05 

(1.01, 1.09) 
1.17 

(1.11, 1.23) 

   50°C  (Increased) 
1.25 

(1.08, 1.42) 
1.07 

(1.05, 1.10) 
1.19 

(1.06, 1.32) 

Expected Range (± 2 SD)* (0.71-1.76) (0.71-1.37) (0.84-1.64) 

 
Conclusion: All of the analytes fell within 2SD of the mean at all temperatures; however, it was 
confirmed during method development that an agitator equilibration/extraction at RT ~ 25°C was the 
optimal choice. 
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B. Critical Parameter Test #3  

Evaluate the significance of the length of extraction of sample from SPME fiber in GC injector  

Test Details:  

(1) Set up the analysis in accordance with the prescribed method. 

(2) Set the extraction time to 10 minutes (reduced time). 

(3) Digest blood QC according to the prescribed method. 

(4) Analyze all digested samples together in one run. 

(5) Repeat the analysis using an extraction time of 15 minutes (reduced time).  

(6) Repeat the analysis using an extraction time of 20 minutes (the method prescribed time). 

Table 16 Critical Parameter Test 3. Length of extraction time. 

Critical Parameter Test 3. Length of extraction time. Results below are the averages of observed results 
at each condition along with the 95th percent confidence intervals (in parentheses).  

QC  
Pool ID 

Sample extraction time 
(minutes) 

InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

10 min.  (Reduced) 
1.69 

(1.58, 1.80) 
1.02 

(0.97, 1.08) 
1.16 

(1.09, 1.22) 

15 min.  (Reduced) 
1.34 

(1.32, 1.38)       
1.04 

(1.02, 1.05) 
1.20 

(1.18, 1.22) 

20 min.  (Per Method) 
1.33 

(1.32, 1.37) 
1.05 

(1.05, 1.09) 
1.17 

(1.14, 1.18) 

Expected Range (± 2 SD)* (0.71-1.76) (0.71-1.37) (0.84-1.64) 

 

Conclusion: All of the analytes fell within 2SD of the mean at all test values; however, it was confirmed 
during method development that 20 minutes was the optimal extraction time. 
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C. Critical Parameter Test #4  

Evaluate the significance of changing GC split ratio. 

Test Details:  

(1) Set up the analysis in accordance with the prescribed method. 

(2) Set the split ratio to 20:1 (reduced ratio). 

(3) Digest blood QC according to the prescribed method. 

(4) Analyze all digested samples together in one run. 

(5) Repeat the analysis using split ratio of 28:1 (the method prescribed).  

(6) Repeat the analysis using split ratio of 35:1 (increased ratio). 

Table 17 Critical Parameter Test 4. GC split ratio. 

Critical Parameter Test 4. GC split ratio. Results below are the averages of observed results at each 
condition along with the 95th percent confidence intervals (in parentheses).  

QC  
Pool ID 

GC split ratio InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

20:1  (Reduced) 
1.31 

(1.26, 1.36) 
1.06 

(1.02, 1.10) 
1.17 

(1.14, 1.19) 

28:1 (Per Method) 
1.34 

(1.29, 1.39)       
1.04 

(1.03, 1.05) 
1.15 

(1.13, 1.19) 

35:1 (Increased) 
1.34 

(1.27, 1.41) 
1.06 

(1.04, 1.08) 
1.17 

(1.15, 1.20) 

Expected Range (± 2 SD)* (0.71-1.76) (0.71-1.37) (0.84-1.64) 

 
Conclusion: All of the analytes fell within 2SD of the mean at all split ratios; however, it was confirmed 
during method development that GC split ratio of 28:1 was the optimal choice. 
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D. Critical Parameter Test #5 

Evaluate the significance of changing GC carrier gas flow rate. 

Test Details:  

(1) Set up the analysis in accordance with the prescribed method. 

(2) Set the flow rate 1.5 mL/min (reduced). 

(3) Digest blood QC according to the prescribed method. 

(4) Analyze all digested samples together in one run. 

(5) Repeat the analysis using a flow rate of 2.0 mL/min (the method prescribed).  

(6) Repeat the analysis using a flow rate of 2.5 mL/min (increased). 

Table 18 Critical Parameter Test 5. GC carrier gas flow rate 

Critical Parameter Test 5. GC carrier gas flow rate. Results below are the averages of observed results at 
each condition along with the 95th percent confidence intervals (in parentheses).  

QC  
Pool ID 

GC carrier gas flow rate 
(mL/min)  

InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

1.5 mL/min (Reduced) 
1.36 

(1.32, 1.39) 
1.07 

(1.04, 1.10) 
1.16 

(1.14, 1.18) 

2.0 mL/min (Per Method) 
1.31 

(1.25, 1.37)       
1.07 

(1.05, 1.08) 
1.16 

(1.13, 1.19) 

2.5 mL/min (Increased) 
1.35 

(1.31, 1.39) 
1.05 

(1.03, 1.07) 
1.17 

(1.12, 1.21) 

Expected Range (± 2 SD)* (0.71-1.76) (0.71-1.37) (0.84-1.64) 

 
Conclusion: All of the analytes fell within 2SD of the mean at all carrier gas flows; however, it was 
confirmed during method development that a carrier gas flow of 2.0 mL/min was the optimal choice. 
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Appendix C: General instructions for uploading data to Starlims 

(1) Open the STARLIMS application and select “Pending Runs Assigned to My Labs”. 

(2) Select the method from the Test drop down menu. 

(3) Click “(+)Add.” Select the instrument system used with the run and click “OK.” 

(4) Click the “All Results (S)” tab. If required, click “[0] Run Instrument Macro.” Once Excel opens, 
select “Enable Content” and follow the prompts on screen to select method, upload 
instrument data file (.csv). Save the file in the folder along with the instrument data file and 
then close it. 

(5) Click “[1] Upload Instrument File”. Use the browser to navigate to the location of the Excel 
file to be imported.  Select your Excel Workbook file, review the data, and click “Upload”. 
Only recognized sample IDs will be uploaded into STARLIMS. Click "Continue". 

• If STARLIMS warns that there is a run date and time stamp conflict between this run and 
any previous run, ensure you selected the correct file for upload before proceeding. In 
the ‘add samples to run’ window ensure sample IDs for the run are recognized as 
eligible before clicking continue. On the ‘results not imported’ window ensure that only 
sample IDs not intended for upload are listed before closing the window. Click 
"Continue". 

(6) Document ‘not tested’ samples, if necessary (e.g., blood clot, missing or empty vial, quantity 
not sufficient) using one of the options below. 

a) Click on the Run Sheet Details tab. Click on the highlighted ‘Click to Search’ text. Use the 
search criteria to populate the samples pending assignment list. Select the sample IDs to 
add to the run and click the “>” arrow button. Further sample information will be added 
in later steps as the entire run is processed. 

b) Click on the Run Sheet Details tab. Click on “Add Unknowns by Barcode” link. Enter the 
sample ID by typing or barcode scanning. Click ‘Ok’ to directly add the ID to the run list. 
Further sample information will be added in later steps as the entire run is processed. 

(7) Select “[2] Mark Null Results”. This will change any null values in NUMRES (i.e., observed 
result) to a pipe tab (|) (e.g., ‘not tested’ samples or analytes not tested for any samples). 

(8) Select “[3] Evaluate Sample QC.”  This will execute the STARLIMS spec schema for the 
method and assign each sample a Results Status message (e.g., Pass, Fail, Warn) and a Status 
Message (e.g., Pass, > 1UB, < LOD, etc.).  

• Review these Results Status and Status Message columns and if necessary, manually 
override the automated entry in “Sample QC Passed” and enter an analyst comment. 
See Table 19 for examples of reasons to override automated “Sample QC Passed”. If you 
are unsure, discuss with your supervisor. 

(9) Select “[4] Evaluate Run QC”. In the pop-up window, the QC pools from the run should 
automatically appear. In “For the following QC results” section, select the radio button “The 
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prior N* results within this date range,” and enter N=40. In “From the following instruments” 
section, select “All instruments.”    

(10) Choose “Proceed to next step” on the QC Evaluation box. If there are not enough QC records 
within the selected date range, select “Cancel” and expand the search date range. If the 
number of records is adequate, select “Start the SASQC Wizard” to begin evaluating the QC 
criteria. 

(11) Select “Save SAS Input File” as “STARLIMS_SAS_data”. The default location for this file is 
C:\Temp, change the network location to save the SAS file in the same 
/Nutritional/Instrument folder file that the data is stored in. Click “Save”.  Select “OK” when 
export is complete.  

(12) Click “Send to SAS Server”. Check that your run number has passed and that your SAS file is 
referencing at least 20 runs. Save a copy of this Report as a .pdf in the data network folder. 
Select “Finished”.  

(13) Click “[5] Set Run QC Statuses”. Select “Proceed” if the QC passes; otherwise change the 
status to fail before proceeding. 

(14) Click “[6] Attach SAS QC File”. Select the PDF version of the SAS output previously saved 
(from Step 12). 

(15) Using the field filtering tool located in the top row of the data field, select “N/A” in the QC 
Type column. 

(16) Click “Set Final Wizard.” Click “Proceed.” Check “Require Sample QC passed” and “Require 
Run QC Passed” in “Step 1: Choose the Set Final selection criteria,” and select “Pass” for 
“Allowable Result Statuses for Set Final.” Click “Proceed.” Verify that the correct number of 
results have been set final. Click “OK.” If the number of results is incorrect (due to incorrect 
sample IDs used or other issues), the run will have to be deleted and reimported. 

• If multiple results for a sample/analyte have been uploaded, the “Set Final Wizard” will 
prompt you to select which result to set final. Set final the first acceptable/repeatable 
result and enter appropriate comment code (common examples: 32 – “dilution 
required,” 33 – “repeated and confirmed.”) 

(17) Before Finishing Results, verify all sample and run QC passes are set correctly. Attach the 
required files to the run, e.g., Instrument file (.xlsx), SAS QC plot (.pdf), Instrument 
performance (.pdf), Calibration curves (.pdf), Report/chromatograms (.pdf).  

(18) Fill in Run Comments and required User Fields. See Table 20 for more information. 

(19) Once you choose “Finish Results”, you will not be able to make revisions. When you are ready 
to report the results, click “Finish Results”. Select the names of the individuals that you want 
to send your run to (the branch QA/QC officers, lab chiefs, etc.) and include your run 
comments in the comments section. 

(20) Notify the appropriate personnel via email that the run is ready to be reviewed. 
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Table 19 Examples of reasons to manually override the automated “Sample QC Passed” in Starlims.  

Event Comment code 

Blood clot 11 (small clot) or 12 (clotted sample) 

Result > High calibrator 103 

Missing vial 18 

Quantity not sufficient (QNS) 21 
 

Table 20 User fields in Starlims 

Field Recommendations Required Examples 

Run 
Comments 

Enter brief information related 
to the batch outcome, e.g.,: 
▪ QC failures 
▪ Confirmations  
▪ Elevated results(>2UB) 
▪ Confirmation run only, if no 
results were set final  
▪ Dilutions performed  
▪ For LOD runs, Instrument 
comparison, Monthly SRM, 
Analyst evaluations runs please 
indicate. 

Y ▪ UPB failed QC. 
▪ Confirmations for BPB and 
BMN 
▪ Elevated results (>2UB) 
▪ Confirmation run only, no 
results set final 
▪ Dilutions performed 
▪ LOD run 
▪ Ext. Calibrator run 
▪ Elevated results, dilutions 
performed, confirmations for 
USR and UPB. 
▪ BMN failed QC, confirmations 
for BPB. 

1 Other general comments 
about the analytical run: 
▪ If calibrator is dropped from 
curve, please specify. 
▪ If a different blank was used, 
please indicate 
QA metric information, if 
applicable* 

Y ▪ Dropped Std.2 for UPB 
calibration curve. 
▪ Reprocessed with aq. blank 
▪ Reprocessed with 2nd cal. 
Curve 
Sample diluted and reanalyzed 

2 Calibrator lot number or ID, or 
Spike solution ID 

Y ▪2022_2208_jyy3  

3 DLS Study number of samples 
in the run: 
▪ DLS study  
▪ PT name 
▪ Note: R&D, LOD 
determination, Analyst 
comparison, if applicable 

Y ▪ 2012-0036, NH99  
▪ NH99 
▪ CTQ QMEQAS, NH99 
▪ Analyst evaluation 
▪ Monthly SRM 

4 Sample Group # Y ▪ SpcAs-1752 
▪ ICS22L01 

5 Corrective action Y (if performed) ▪ changed column 
▪ new spike solution was 
prepared and samples re-spiked 
and redigested 
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Field Recommendations Required Examples 

6 Column ID Y (chromatographic 
method) 

▪ Column Serial Number 308 

 

7 Lab Chief / Team Lead check N (only used for R&D 
runs) 

▪ DMJ  

8 Hamilton Identifier Y ▪ ML600FG9017 
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Appendix D: Template for Working Triple Spike Standards Solution 

 

Figure 13 Excel template used for calculations using ISC standards. 

 

  

Experiment: Date:

1. Starting Stock Standard Solutions: Units

Vendor AIT, Inc. In[199]Hg Me[200]Hg Et[201]Hg

Description: Isotopically enriched isotopes (µg/g) 5.1358 4.9937 5.0570

Lot#, Date:

2. Pipet isotope stock standard sol. into 3 separate tared 1.5 mL microcentrifuge tubes. Cap tubes. Obtain net weights. 

In[199]Hg Me[200]Hg Et[201]Hg

2a. Volume (µL) 50.0 50.0 50.0

2b. Wt with added Isotopes (g)

2c. Tube Tare wt. (g)

2d. Isotope Stock Sol., Net wt., calc (g) 0.00000 0.00000 0.00000

3. Add water to above tubes using volumes indicated below. Cap tubes and weigh.  

In[199]Hg Me[200]Hg Et[201]Hg

3a. Volume of water/diluent added (µL) 400.0 400.0 400.0

3b. Gross wt after water/diluent addtion (g)

3c. Tube tare wt. from (line c) above (g)

3d. Isotope solution, dilution #1, net wt. (g) 0.00000 0.00000 0.00000

Dil. #1 dilution factor ( line 3a ÷ line 2d )

3e. New concentration of isotopes (dilution #1)* (µg/g)

* If diluted, otherwise concentration remains unchanged from original stock standard solution. 

4. Weight a 50 mL tube or volumetric flask then fill with approximately 0 mL of water (exact amount is determined below). 

4a. Determine tare wt of tube or volumetric flask. (g)

5. Quantitatively transfer the indicated volumes of each isotope to the 50 mL tube/volumetric flask containing water. 

In[199]Hg Me[200]Hg Et[201]Hg

5a. Vol dil #1 isotope std transferred to 50 mL tube/flask (µL) 100.0 100.0 100.0

If isotope standard was not diluted, quantitatively transfer entire amount, with 3x washings, to 50 mL tube/flask. 

Rinse pipet tips in receiving tube's own solution. Recap the 1.5 mL tubes containing isotopes dilution #1. 

6. Re-weigh each 1.5 mL tube containing remaining dilution #1 of each isotope standard solution.  

In[199]Hg Me[200]Hg Et[201]Hg

6a. Gross wt of 1.5 mL tube + remaining dil #1 solution (g)

6b. Gross wt of 1.5 mL tube + original dil #1 sol (line 3b) (g)

6c. Wt. of dilution #1 isotope used to make dilution #2 (g)

(for isotopes not diluted in Step 3, copy value from line 2d to line 6c)

7. Weigh the 50 mL tube containing all isotope standard additions.

7a. 50mL tube/flask tare wt + final solution wt (g)

6. Calculate final working triple-spike concentrations.

In[199]Hg Me[200]Hg Et[201]Hg

6a. Concentration of dil #2 isotope solutions (line 3e) (µg/g)

6b. Dil. #2 dilution factor ( [line 7a - line 4a] ÷ line 6c)

6c. Final Diluted Working Spike Conc (line 3e ÷ line 6b) (µg/kg)

7. Add the following volume of working triple-spike solution to each sample. 

In[199]Hg Me[200]Hg Et[201]Hg

7a. Vol working triple-spike solution to add per sample (µL) 100.0 100.0 100.0

7b. Final Weight of each isotope added per sample (ng)

Triple-Spike Spiking Solution Preparation
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Appendix E: Electronic Instrument Performance log sheets 

 

Figure 14 Electronic instrument performance log sheet 

 

 

Figure 15 Electronic instrument maintenance log sheet 

   

Instrument name: 

If instrument sensitivity is low (e.g., peak areas are not > 300 cps) perform instrument maintenance on Instrument Maintenance worksheet. 

Date of instrument use (mm/dd/yy)>> Date (mm/dd/yy)>>

Operating Analyst (User ID) Operating Analyst (User ID)

Vacuum Press Before plasma ignition

(enter NA if plasma was already on)
Glass Liner

Vacuum Press. After plasma ignition GC Injector Septum

Detector Voltage (Pulse Voltage value) Left SPME Fiber

MeHg Peak Area-LB QC diluted 10X (>300 cps)

(enter √ = pass, X = fail)
Right SPME Fiber

EtHg Peak Area-LB QC diluted 10X (>300 cps)

(enter √ = pass, X = fail)
Other Notes

 

IHg Peak Area-LB QC diluted 10X (>300 cps)

(enter √ = pass, X = fail)
Type of Analysis Work/Group Numbers 

Analyzed

(enter NA if samples were not analyzed)
Triple Spike ID

(enter NA if samples were not analyzed)

Notes

I = inspect; R = replace

"10 run" maintenance
(complete after 10 days of use)

Information in the table below is only required on days the instrument was used 

Instrument Performance Records

After 10 days of instrument use: copy a new table from the Performance Temp worksheet, and paste below the current table

ICP-MS service from vendor (PMV or other service)

PAL autosmapler service from vendor (PMV or other service)

GC service from vendor (PMV or other service)

Computer reboot

Verify ISLE and MUST drive backups

Date of maintenance (mm/dd/yy)>>

Analyst performing maintenance (User ID)

Injector

Torch 

RF Coil 

Sampler cone (Sa)

Skimmer Cone (Sk) 

Xe optimization (X-Y)

(Y= yes, N= no)

Xe (cps)

(enter NA if not performed)

Xe % RSD

(enter NA if not performed)

GC Injector 

GC Capillary Column

 Capillary Column Cut

(enter "I" for inspected, or "cut")

Notes

Date  (mm/dd/yy)>>

Operating Analyst

Xe (cps)

Xe % RSD

Xe optimization (X-Y): is performed everytime the plasma is turned ON

Do not leave empty cells in the tables below.

When all columns of a section are filled, copy a new section from the Maintenance Temp worksheet and paste it below; do not add colums.

Xe optimization (X-Y) only after plasma ignition

Instrument service: record date of service below for quick reference; see paper instrument service log in the instrument logbook for additional details and resolutions

Computer maintenance: record date of maintenance below; complete montly

Instrument service - record date service occurred

Computer maintenance - record date of maintenance

Instrument maintenance: performed when instrument sensitivity is unacceptable; use the Notes section to indicate additonal reasons for maintenance. Can involve cleaning and/or replacing items listed below, however inspection is 

allowed

Instrument maintenance if instrument perfomance is poor   I=inspected   R=replaced 
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Appendix F: Operation of the UltraCLAVE Microwave Digestion System for the 
Mercury Speciation Analytical Method  

A. Background 

During the preparation of samples for the mercury speciation isotope dilution method, due to 
the amount of protein and fat in blood, it is necessary to use a strong acid or base to release 
metallic species. Tetramethylammonium hydroxide (TMAH) is used in method DLS 3020 to 
solubilize protein and release bound mercury species. TMAH was chosen because it produces 
precipitate-free digested samples, therefore eliminating the need for a centrifugation step in 
sample preparation. At room temperature, approximately 72 hours is required after TMAH 
addition before the mercury species can be quantified using this analytical method. Placing 
blood samples in a convection oven for approximately 20 hours at 80°C accelerated the 
digestion process and became the chosen digestion route. This digestion method works well; 
however, 20 hours is not practical in situations where expedited analyses are required. To 
reduce the digestion time and make the method more suitable for emergency response type 
analyses, we developed a new digestion method using the Milestone UltraCLAVE microwave 
digestion system which takes less than one hour. In terms of advantages, the UltraCLAVE 
microwave is easy to use, requires minimal maintenance, and allows for high sample 
throughput. Additionally, this system allowed us to reduce the digestion time without making 
any additional modifications to our sample preparation procedure.  

B. Safety Precautions 

 

Follow universal precautions. Wear gloves, a lab coat, and safety glasses while handling human 
blood, plasma, serum, urine or other bodily fluid or tissue. Place disposable plastic, glass, and 
paper (e.g., pipette tips, autosampler tubes, and gloves) that come in contact with human 
biological fluids, such as urine, in a biohazard autoclave bag. Keep these bags in appropriate 
containers until they are sealed and autoclaved. When work is finished, wipe down all work 
surfaces where human biological fluid was handled with a 10% (v/v) sodium hypochlorite 
solution. Dispose of all biological samples that are slated for disposal and diluted specimens in a 
biohazard autoclave bag at the end of the analysis according to CDC/DLS guidelines for disposal 
of hazardous waste. 

C. Objective 

This appendix will describe the steps needed to operate the UltraCLAVE Microwave Digestion 
System for the speciated mercury method (DLS 3020 Blood mercury speciation performed by 
TSID-GC-ICP-DRC-MS). The steps used for the microwave digestion method were programmed 
during the set-up of the station and do not have to be modified unless there is a change in the 
process. Please refer to the UltraCLAVE User Manual for the detailed description of the 
UltraCLAVE system, safety rules, operations, service/maintenance, and easyCONTROL software. 

D. Consumables and System Components 

(1) Consumables 

Precautionary information that is important to protecting personnel and safeguarding equipment 
will be presented inside a box, such as this one, throughout the procedure where appropriate.  
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a) UltraCLAVE Metal O-ring (Catalog #: WZ00046) Milestone, Shelton, CT or equivalent. 
b) UltraCLAVE Flat O-ring (Catalog #: OR0001) Milestone, Shelton, CT or equivalent. 
c) Heavy wall 12x75mm borosilicate glass test tubes (Fisher brand catalog #: 14-958-10B) 

or equivalent. 

(2) System Components 

a) Microwave Digestion System (UltraCLAVE, Milestone Inc., Shelton, CT) or equivalent. 
b) 3.5L PTFE base load vessel (Catalog #85260, or equivalent, Milestone UltraCLAVE) 
c) 77 position WEFLON-PTFE sample rack (Catalog #: UC85034) Milestone, Shelton, CT or 

equivalent. 
d) Chiller: Lab Tech SMART H150-1000 or equivalent. 
e) Compressor: L&W Compressors LW-100-E1 or equivalent. 
f) Exhaust/ventilation  
g) System computer (TERMINAL 1640, easyCONTROL software) 

(3) Chemicals and Solutions 

a) Water, high purity ≥ 18 MW×cm resistivity (Aqua Solutions, Jasper, GA) 
b) Sulfuric Acid, (CAS# 7664-93-9), (H2SO4-MW 98.08), (Fisher Scientific, Norcross, GA), 

TraceMetal grade, item # A510-P500, or equivalent.  
c) Hydrogen Peroxide, 30% solution, stabilized (CAS# 7722-84-1), (H2O2, MW 34.0), (EMD 

Millipore, Germany), item #386790, or equivalent. 
d) Nitrogen gas, high purity (item #NI HP300CBA, Airgas, Atlanta, GA) 
e) Bleach (1:10 dilution of a standard sodium hypochlorite solution) from any vendor. 

Note: To prepare base load for digestion, 2mL of sulfuric acid and 30 mL of hydrogen 
peroxide are added to 320mL of DI water (Detailed preparation instructions are found 
on Pg. 17 “Digestion Method 2” of Section D “Sample Preparation”). 

 

Figure 16 How to prepare base load for digestion 
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E. Procedure  

(1) Start-up  

a) Turn the UltraCLAVE main switch ON (located on the bottom, right side of the system). 

 

b) The UltraCLAVE is ready to start. The terminal is automatically turned on, and the 
program is initialized.  

c) On the instrument controller (laptop-like item), click on the UltraCLAVE icon  (top right 
corner), select Administrator and put in the password “123456” or User with the 
password “123” to open the program that controls the microwave.  

d) After Login, the start page of the easyCONTROL-640 (software operating the 
UltraCLAVE) is opened. 

 

Figure 17 Instrument controller window 

e) The status bar (as shown below) which is found below the four sections above shows 
the current parameters. 
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Figure 18 Status bar showing current parameters  

f) Refer to the subsection “Digestion Method 2” in Section 8.B(3) for instructions on the 
preparation of samples for microwave digestion. 

g) Place the sample rack with pre-labeled 12x75mm glass test tubes containing blood 
samples on the hanger in the vessel area (see the following figure taken directly from 
the UltraCLAVE users’ manual). 

 

Figure 19 Hanging-up samples with fixed PTFE cover 

h) Pull the black knob on the side of the UltraCLAVE cover, and close the Plexiglas shield. 
i) Close and lock the doors of the UltraCLAVE enclosure. 
j) Open the nitrogen cylinder valve. The pressure should be set at 80 psi. 
k) Turn on the chiller, which should be set at 8°C. 

(2) Starting the Run 

a) Click on the “Method” tab. 
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Figure 20 Method tab 

b) The  tab is where parameters controlling the UltraCLAVE microwave’s initial and 
ending operations can be filled in.  

c) The parameters used for this method are listed in Error! Reference source not found.: 

 

Table 21 easyCONTROL parameters 

Parameter Setting or Status 

Load pressure 40 bar 

Vessel cooling 
 

Pressure after run 
 

Vessel after run 
 

Release rate 10 bar/min 

Beyond 50°C 

Temperature below 80°C 

 

d) On the next  tab, parameters (Time, Temperature, Power, and Pressure) for 
sample digestion are inputted. Error! Reference source not found. lists the parameters 
used for this method.  

e) The “Info” tab -  is where additional information about rack and reactor 
vessels can be added (such as any notes specific to that digestion). 
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Figure 21 Method tab displays time, temperature, power, and pressure 

  

Table 22 UltraCLAVE Digestion Settings 

   

Time (h:m:s) Energy (W) T1 (°C) T2 (°C) P (bar) 

00:10:00 1000 150 80 100 

00:04:30 1000 150 80 100 

 

f) When all the parameters are filled in, press the green “START” button. This method is 
now active, and sample processing will commence. 

g) The entire digestion time is approximately 40 minutes including cooling of the system. 
h) While the microwave program is running, the software monitors all the controlled 

parameters data. The profiles of temperature, pressure and microwave energy are 
plotted in real time in the “Graph” section (same as “RUN” tab on some versions of the 
software).  
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Figure 22 Graph displaying time, temperature, power, and pressure during the digestion run 

i) At any point during the run, the UltraCLAVE can be stopped with the emergency STOP-

Button  . While the system is in operation, the “Stop” button shows up instead 
of “Start” in the picture above. Additionally, there is a large red emergency STOP button 

on the control panel of the UltraCLAVE instrument  that can be pressed. 

j) By selecting  , it is possible to follow the status of each UltraCLAVE 
mechanism during the process of a run. In case you need to stop the automatic run, the 
system is operated directly from here. 

 

Figure 23 System tab displaying status of UltraCLAVE mechanism during the process of a run 
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k) After the run is complete, save the data by pressing  tab in the “RUN” window. Name 
the method “date_temperature_sample(group)name”. 

(3) Cleaning the microwave digestion system 

a) Using a deionized water squirt bottle, rinse the three channels (measuring block, 
pressure inlet, and pressure drain valve).  

 

Figure 24 Cleaning procedure, rinsing three channels 

b) Wipe and dry the PTFE cover, the steel cover laterally, and the clamps with paper towels 
to remove the condensate.  

   

Figure 25 Drying procedure of the microwave digestion vessel 

c) After drying, spray a small amount of “The Dry Lube” (B’Laster Corporation, Cleveland, 
OH or equivalent) on a clean cloth, and rub it on the clamps to protect them from 
corrosion. 

d) Both the O-ring for pressure sealing (green colored pressure sealing O-rings) (A) and the 
metal high frequency ring (B) must be intact. If either is damaged, replace right away. 
The O-ring should be lubricated with Silicon Grease (RS Components Ltd., UK or 
equivalent) upon installation and after every three or four digestions. 

e) Take out the PTFE -insert vessel (picture below), and discard the base load solution. 
Rinse and then dry the PTFE vessel and the inside of the metal vessel. After drying, spray 
a small amount of “The Dry Lube” onto a clean cloth and wipe the sides of the metal 
vessel where the clamps close.  
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Figure 26 Inserting digestion vessel into pressure chamber 

F. Documentation of System Maintenance 

Computer Maintenance: Record any maintenance of computer hardware in the instrument 
logbook. When changes are made to methods, back up the methods to CD. Make two copies – 
place one in the laboratory and one in the fireproof CD storage location. Also, place the backup 
file for the methods on the shared network drive under the instrument folder for the 
UltraCLAVE. 

Instrument Maintenance: Document system maintenance in the instrument logbook and 
assigned laboratory notebook. Record any maintenance performed by service engineers. 

G. Troubleshooting  

This section will serve as a troubleshooting guide for the issues experienced by this laboratory 
during operation of the microwave. This section will be amended as needed as problems are 
encountered. Any issue not listed in this section will have to be discussed with a service 
engineer. 

Clamp overload: If during the beginning or end of the microwave operation an error window 
appears that gives a message “left or right clamp overload”, this means that the vessel cannot 
be opened/closed and the clamps are stuck. Go to the “System” tab and manually open the 
clamps by pressing the green arrows (see picture below highlighted by red box). Then lower the 
vessel by pressing the “down” green arrow (selected by black box). Lubricate clamps before next 
digestion. If the problem persists, contact a service engineer.  
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Figure 27 System tab showing the status of UltraCLAVE mechanism during the process of a run 

Compressor trips a breaker: L&W Compressors LW-100-E1 trips the breaker as it goes over 
allowed power usage (>20 Amps). This sometimes happens if the nitrogen tank is too low. The 
nitrogen is set to 80 psi, but it has been observed that when the cylinder gets close to 500 psi, 
the compressor trips the breaker. If the breaker is tripped and the nitrogen cylinder is not 100% 
full, replace it. If the problem persists, contact a service engineer. 
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Appendix G: Programming NexION® Method 

A. Programming the DRC Gas Flow Delay Parameter

A special DRC™ setting, called "Flow Delay", needs to be changed from its default setting to
avoid the problem of the ICP-MS software forcing a time delay of several seconds before
collecting data at the start of a chromatographic run when in DRC mode. With the NexION®,
this setting can only be changed by entering the NexION® software's service mode. This
change only needs to be done once per software installation or upgrade, or if the setting
was deliberately changed by a field service engineer. It is a good idea to inform the service
engineer who intends to perform work on the instrument of the importance of returning the

"Flow Delay" to the non-default value of 1. 

(1) From within the NexION® software in the “Instrument Control Session” window, choose
menu item Options > Configuration.

(2) Click on the “set” button under the “Cell Gas Delays” section. If the “Flow Delay” (Gas
changes while in DRC™ Mode) setting is a value other than “1”, change the value in the
field named “Flow Change” to “1”. Click “Apply” then click “Close.”

B. Programming the NexION® ".mth" file

(1) If it is not already open, launch the NexION® program and in the "Instrument Control
Session" window, click "File" > "Review Files". Click the "Load" button for "Method" (the
first item on the list). Navigate to the folder “C:\Users\Public\Documents\PerkinElmer
Syngistix\ICPMS\Method” and click on the "Hg DRC.mth" file followed by "Open".

(2) If the "Hg DRC" file cannot be found, or it has been changed or corrupted in a manner
that makes its use questionable, close the open file dialog box and close the Review
Files window by clicking the "Done" button. Complete the following steps; otherwise,
proceed to step 3:

(a) Make the active method file the active window (do this by clicking on the tool bar
icon that looks like a notepad with a "Cu" on it). Then click "File" > "New" on the
menu bar and choose "Data Only" in the New Method window that appears. Click
"OK" then maximize the window. Fill in this window with the information in Error!
Reference source not found..

Important! 

While in Service Mode, DO NOT make changes to any setting except for the one change described below. 
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Table 23 NexION® Timing Parameters 

Parameter Setting 

Sweeps/Reading: 1 

Readings/Replicate: 2272 

Number of Replicates: 1 

Tuning File: C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS\MassCal\Default.tun 

Optimization File: C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS\Conditions\Default.dac 

 

(b) On the first line of the worksheet-like table, click in the cell of row 1 of the "Analyte 
(*)" column. Type "Hg" then press "Enter" key. The row will suddenly be filled-in 
with mercury's "Begin Mass (amu)" of 201.971 (or something close) and several 
default parameters. Right click on "Hg" and a periodic table will appear. Select five 
Hg isotopes from mass ~197.9670 to ~201.9710 and click "OK". All five isotopes will 
be seen in the "Analyte (*)" column. Tab to next cells and fill in the information 
shown in Error! Reference source not found.. 

Table 24 NexION® Analyte Parameters 

Parameter Setting 

Analyte: Hg 

Begin Mass (amu): 197.9670* (first row, then proceed to the 4 other 
isotopes) 

End Mass: <leave empty> 

Scan Mode: Peak Hopping 

MCA Channels: 1 

Dwell Time per AMU (ms): 25 

Integration Time (ms): 56800 (automatically determined by software) 

Profile: Argon DRC 

Argon Flow: 0.5† 

RPa: 0 

RPq: 0.3† 

*Actual mass may differ by a few hundredth of amu. 

† Suggested starting values only. Optimum parameters will depend on the outcome of the 
optimization procedure. 

(c) Click on the "Processing" tab and enter the following information (): 
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Table 25 NexION® Processing Parameters 

Parameter Setting 

Detector: 

Blank Subtraction: 

Dual 

After Internal Std. 

Measurement Unit: Cps 

Process Spectral Peak: Average 

Process Signal Profile: 

Baseline Readings: 

Average 

0 

Apply Smoothing: Unchecked 

QID: Off 

Isotope Ratio Mode: Off 

 

(d) Skip the "Equation" tab. Click on the "Sampling" tab and enter the following 
information (Error! Reference source not found.): 

Table 26 NexION® Sampling Parameters 

Parameter Setting 

Peristaltic Pump Under Computer Control: Checked 

Sampling Device: External 

 

(e) Click on the "Report" tab and enter the information in Error! Reference source not 
found.. 
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Table 27 NexION® Report Parameters 

Parameter Setting 

Report View | Send to 
Printer: 

Unchecked 

Report Options 
Template: 

<leave empty> * 

Automatically 
Generate NetCDF File: 

Checked 

C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS\ReportOutput\ 

Report to File | Send 
to File: 

Unchecked 

Report Options 
Template: 

<leave empty> * 

Report File Name: <leave empty> * 

Report Format: <leave empty> * 

File Write Option Append * 

  Use International   
Character Set 

Unchecked 

*Content of these fields is not important since Send To Printer/File is 
unchecked. 

 

(f) Choose menu item "File" > "Save As" and navigate to the "C:\ 
Users\Public\Documents\PerkinElmer Syngistix\ICPMS\Methods\" folder. Enter "Hg 
DRC" as the name of the method file and click the "Save" button. 

(g) The NexION® method "Hg DRC" is now loaded into memory. 
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Appendix H: Setting up TotalChrom Integration Method and Chromlink  

A. Configuration of TotalChrom™ Integration Method 

The following information is presented as a starting point to help the analyst develop robust 
integration method parameters that will work best for most chromatography data. Many of 
these parameters will work just fine as presented below. However, the separation chemistry of 
GC columns can vary due to frequency of use, column replacement, or because of individual 
sample "oddities". Some parameters may need to be adjusted from time to time to maximize 
the ability of TotalChrom™ to properly integrate peaks and identify components with minimum 
operator intervention. Therefore, the analyst must pay particular attention to the 
chromatograms produced in every run and make necessary adjustments as warranted. The 
analyst must be familiar with the TotalChrom™'s frequently used integration functions, which 
are described in Chapter 18 of TotalChrom™ Workstation User's Guide: Volume II. 

(1) The creation of a new method file in TotalChrom™ is done the first time TotalChrom™ is 
setup, or it will need to be recreated if the file "Hg.mth" cannot be found or has been 
corrupted. In the TotalChrom™ Navigator window, choose the menu item "Build" > 
"Method." In the next dialog box, click the "Create a new method" radio button and click 
"OK." The default method will load into the method editor.  

(2) Click on the "Components" item in the menu bar in Method Editor. If the menu item 
"Delete All Components" is not grayed out, select it and click "OK" when prompted to 
"Delete all components, calibration levels, and calibration replicates". 

(3) Choose the menu Item "Process" > "Integration". Click on the "Integration" tab in the 
"Process" window. Enter the information shown inError! Reference source not found.. 
These values are to be used as a starting point, but the analyst may make appropriate 
changes to one or more of the integration parameters as necessary. 

(4) Click on the "Baseline Timed Events" tab. Enter the information shown below in Error! 
Reference source not found.. The analyst may make appropriate changes to one or more 
of the Baseline Timed Events as may prove necessary. 

(5) Click on the "Optional Reports" tab. Uncheck the box for "Keep temporary files". 
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Table 28 Integration 

Basic Parameters Advanced Parameters 

 Value  Value 

Bunching Factor (pts): 1 Peak Separation Criteria  

Noise Threshold (µV): 73 Width ratio : 0.200 

Area Threshold (µV): 368.00 Valley-to-peak ratio : 0.010 

    

  Exponential Skim Criteria  

  Peak height ratio : 5.000 

  Adjusted height ratio : 4.000 

  Valley height ratio : 3.000 

 

Table 29 Baseline Timed Events 

Defined Events 

Time Event Value Code Level 

0.000 Set Area Threshold  100.00 AT  

0.000 Set Noise Threshold 25 NT  

0.000 Smooth Peak Ends On 5 +SM  

0.000 Set Bunching Factor 3 BF   

 

(6) Click on the "Replot" tab. Enter the information shown in Error! Reference source not 
found.. The analyst may make appropriate changes to one or more of the Replot 
parameters as may prove necessary. 

(7) It is unnecessary to click on the "User Programs" tab because it is not used. Close the 
Process window by clicking on the "OK" button. 

(8) In the Method Editor window, choose the menu item "Components" > "Global 
Information." Click on the "Integration" tab in the "Process" window. Enter the information 
shown in Error! Reference source not found.. 

(9) The "LIMS Results" tab is not used. Click the "OK" button to close the window. The 
parameters in Error! Reference source not found. are starting points. The analyst may 
make appropriate changes to one or more of the Global Information parameters as may 
prove necessary. 
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Table 30 Replot 

Plots Miscellaneous 

Generate a separate 
replot : 

checked Start plot at end of 
delay time : 

checked 

Number of pages: 1 Gradient overlay : not checked* 

Retention Labels : Top of Plot* Draw baselines : checked* 

Component Labels : Actual time Timed events : checked* 

Scaling Type : Vertical scaling Plot Title : Chromatogram 

Scaling Parameters  X axis label : Time [min] 

Scale Factor : 1.000000* Y axis label : Response [mV] 

 

Table 31 Global Information 

Volume units : 

Quantitation units : 

µL 

ng 

Unidentified Peak 
Quantitation 

Calibration factor : 

 

 

1.000000e+06 

Sample Volume (µl) : 1.000 Always use calibration 
factor : 

selected 

Void time (min) : 0.000   

Calibration  RRT Calculation  

External Standard selected Use first peak in run 
as RRT reference:  

selected 

Reject outliers during 
calibration : 

not checked   

Sample Amount Options    

Correct amounts for 
calibration standards : 

not checked   

Convert unknown 
samples to 
concentration units: 

checked   

 

(10) In the Method Editor window, choose the menu item "Components" > "New Component." 
The white list box in the left portion of the window will be empty. Click in the empty field 
labeled "Name" and type "Hg0". Press the tab key and enter "1.614" in the field labeled 
"Retention time". Select the radio button labeled "Peak" if it is not already selected. Leave 
the other fields and check boxes unaltered. Click the "New Component" button. Enter each 
of the component names and parameters listed in Error! Reference source not found.. 
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Table 32 Method Editor -- Components Settings 

Name 
Retention 

Time 
Absolute 

window (s) 
Relative 

window (%) 
Find tallest peak in 

window 

Hg0 1.203 2.00 3.00 Not checked 

InHg 3.122 0.00 3.00 Not checked 

MeHg 2.312 0.00 3.00 Checked 

EtHg 2.833 0.00 3.00 Not checked 

(11) Click the "New Component" button before starting a new component. After entering the
last component, click the "OK" button. The values for Retention Time, Absolute Window,
and Relative Window serve as starting points. The analyst may alter these values as actual
chromatographic results may dictate.

(12) In the Method Editor window, choose the menu item "Components" > "Defaults." Click on
the "Identification" tab". Enter the information shown in Error! Reference source not
found..

Table 33 Components Defaults – Identification 

Parameter Setting Parameter Setting 

Component Type : Peak Reference : blank 

Absolute window (s): 0.00 Internal Standard : blank 

Relative window (%): 3.00 Find tallest peak : Not checked 

(13) Click on the "Calibration" tab in Components Defaults Window. Enter the information
shown in Error! Reference source not found.

Table 34 Components Defaults – Calibration 

Parameter Setting Amount (µV·s/ng) 

Calibration Type : Use Calibration Factor 1.000000e-6 

Scaling : None 

Weighing :  None 

Response :  Area 

(14) The "User Values/LIMS" tab is not used. Close the "Components Defaults" window by
clicking the "OK" button.
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(15) In the Method Editor window, Choose "File" > "Save As." A window appears inviting you to 
enter any information pertinent to this method, which will be saved with the method. 
Enter your name and the date this method was created. Click "OK" and a "TotalChrom File-
Save-As" dialog box opens. Navigate the directory tree to get to the folder 
C:\GC\Methods). Double-click on this folder. In the "File name:" field, enter "Hg-
Template.mth". If there is already a file in that folder with the same name, highlight that 
file and right-click the mouse. Choose "Rename" and give the file a new name (e.g., add 
"backup" to the name). Now, you can click the "Save" button. Close the "Method Editor" 
window. 

B. Configuration of ELAN® ChromLink™ 

ELAN® ChromLink™ will be configured after initial installation of the program or when the 
NexION® tune ("default.tun") file is re-optimized, and when there is available at least one recent 
NexION® NetCDF file (with the ".nc" extension) containing data for the mass of interest that was 
collected since last update of the "default.tun" file. 

(1) Launch TotalChrom™ Navigator. In the resulting TotalChrom™ Navigator window, choose 
menu item "Apps" > "ChromLink™" (alternatively, you may launch ChromLink™ from the 
operating system Start > Programs menu). 

a) Inside the ELAN® ChromLink™ window, click on menu item "Configuration" > "Default 
TotalChrom Method". Click on the "Browse..." button and navigate to the directory 
C:\GC\Methods\. Select "HgSpecGC1.mth," and click the "Open" button. 
"C:\GC\Methods\HgSpecGC1.mth" will now be the ChromLink™ default method. Click 
"OK" to close the "Default TotalChrom Method" window.  

b) Inside the ELAN® ChromLink™ window, click on the "Set" button. A window titled 
"Operating Mode" will open. Inside the ELAN® ChromLink™ window, click on the "Set" 
button. A window titled "Operating Mode" will open. Click on the "Automatic - process 
all NetCDF files in specified location" radio button. The lower radio buttons will gray out. 
Click the "OK" button to close the window. 

c) Click on the "Browse" button by the ”ELAN® NetCDF file - location/file to be converted" 
space. Choose the path "C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS\ReportOutput". The location/file to be converted will now read 
"C:\Users\Public\Documents\PerkinElmer Syngistix\ICPMS\ReportOutput\*.nc".  

d) Click on the "Browse..." button for "ELAN® NetCDF ChromLink™ file location (sequence 
and raw files generated by ChromLink™)" field. An open file dialog box will open; choose 
the file location to which all the data will be directed (usually the data file that was 
created that day). 

e) Click on the "Start Processing ELAN® Data Files" button. A window titled "Processing 
ELAN® Data" will appear. 

  

Mercury:  Inorganic, Ethyl, and Methyl - Blood 
NHANES August 2021 - August 2023

90 of 91



(2) At this time, ChromLink™ may be closed by selecting "File" > "Exit." Click "OK" at the dialog
box asking if you want to quit ChromLink™.

(3) In addition to configuring ChromLink™ itself, it is necessary to alter one value in the "seed"
method file that ChromLink™ uses to set a select number of parameters to certain default
values. This step only needs to be done once following the installation of ChromLink™.

a) In the TotalChrom™ Navigator window, choose the menu item "Build" > "Sequence" and
a dialog box called "Startup" will appear. Click on the radio button labeled "Load
sequence stored on disk" then click the "OK" button. Navigate to the folder on the C
drive that contains the ChromLink™ program file (usually in C:\PenExe\ChromLink™ but
if it is not there, check under the C:\Program Files directory). Click on the sequence file
"seed.seq" to highlight it (if this file is missing, reinstall ChromLink™). Click the "Open"
button. A spreadsheet style sequence table will present itself in a window called
"Sequence Information - Channel A". There will be a minimized window for channel B
data; ignore this window.

b) Choose menu item "File" > "Save." Close the Sequence Editor window by choosing "File"
> "Exit" from the menu bar.
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